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Getting Started

About CW Evolve

CW Evolve is a powerful and customizable web platform which can be configured to offer different
experiences for different audiences within your organization.

Using Evolve you can share information from your CW repository across your organization - but only the data
you want to share.

Depending on your configuration and the roles you set for  your users, people can either read the data, follow
it to keep up to date, comment on it, or even edit it directly.

System Architecture

ACTIVE DIRECTORY
(OPTIONAL)

CLIENT DESKTOP

v

EVOLVE WEB SERVER CASEWISE REPOSITORY ™
Casewise Suite
-— E O E = = W = .
I
CLIENT DESKTOP
] H/ ¢ D
Evolve Web Application SOL Server or Oracle
Casewise Suite
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Key Concepts

To help understand Evolve and the instructions in this guide, this page lists the key concepts you'll run into

when working with Evolve.

Sites

Evolve deployments are called Sites - that is a collection of custom web pages based on data from a CW

Model. In Evolve, these web pages are called Index Pages and Object Pages .

You can deploy your Site in two ways: as a Static Site , or a Dynamic Site - or both, if you have a Dynamic
license.

You can create as many Sites as you like but only one per Model.

see URLSs, file paths and directory structuresto understand the URLs used to access your Sites

Top-level IIS Site

The top-level 1IS Site is only used when Dynamic Sites have been deployed and lists all the Sites the logged
on user has permission to view. Users can choose a  Site to view and then that Site is displayed.

Evolve Static

A Static Evolve Site is a read-only deployment which displays data from your repository taken at a fixed
point in time. It is therefore not live data and does not allow anyone viewing the web page s to edit it.

Static Sites do not support user login and therefore do not support access control or social features such as

Comments, Questionnaires and Favorites .

Evolve Dynamic

A Dynamic Evolve Site shows live data from the CW repository and allows peopl e viewing the data to edit it -

assuming you have configured it that way and the users have sufficient permissions to do so.

Using Evolve's social features, a Dynamic Site enables Followers to read the data, create a custom
homepage and set favorite pages, while Contributors can additionally edit data and participate in the review

and approval workflow .

erwin Evolve 2 User Help Guide |
Getting Started |



Index Pages

Index Pages are the top -level pages in your Site. They are the pages that the main Menu navigation links to
and they are generally the starting point for users browsing your Site.

Index Pages essentially display lists or representations of objects which can be expanded on by supporting
Object Pages which show more information about the object in question.

There are three types of Index Page:
1. Object listing page s, such as lists, tables, or boxes .
2. Graphical page s, such as dashboards and charts .

3. Diagram page s, showing CW Modeler diagrams or visualization diagrams.

Object Pages

An Object Page is used to present the details of an object instance - you select an object on an Index
Page, and the Object Page displays its properties. You must have an Object Page configured for each type of
object you want to see the details of in your Evolve Site.

Views

An Object Page can be configured to offer more than one  View of the object being observed. If you
make more than one Object Page for an Object Type, these pages will be offered as Views to the user. The

links to the different Views are displayed as sections in the page's left  -hand navigation panel.

Layouts and Behaviors

There are many ways you can display your data in Evolve web pages. The basic display options for Index
Pages and Object Pages are simple lists or property groups. You can however use a wide variety  of layouts
and behaviors to extend on these basic display options to include elements such as Pie Charts, Bubble

Charts, Cost/Benefit Charts, Bar Charts, Maps, Roadmaps and Tables.

Evolve Designer

Evolve Designer is the d esktop application you use to create, configure and manage your Evolve Sites. It is

installed on the web server machine which hosts your Evolve Site.
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Diagram Designer

Diagram Designer is the desktop application you use to create and configure Diagram Visua lizations. It is
installed on the web server machine which hosts your Evolve Site.

Roles

Roles are used to group users for the purpose of control Site access and capabilities.

You use Roles to control visibility to your Site pages, as well as whether those  users are Social or
Contributing users - so who is a read -only user and who can also edit data.

In addition, Roles are used in Evolve Workflow to determine which users must review and approve other
users' edits to data.

Deployment

A Deployment is the location of your published Evolve Site running on a web server. Once you create and
configure your Site, you deploy it to the web server so other people can access it.

Workflow

Workflow is a component of Evolve which provides some useful workflow processes based on creating,
editing and deleting data, as well as reviewing content.

Glossary

The terms mentioned above are only some of the concepts you'll come across when working with Evolv ~ e.

For a full list of the common concepts and terms, please use the Glossary in the left  -hand pane.
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Meta Model Considerations

Your model's meta model is a consideration for Evolve for the following reasons
1. When you create an Evolve Site, certain changes are made to your model's meta model

2. Certain Evolve features, such as graphs, dashboards or features on Object Pages, can only be used if

your objects have specific corresponding Property Types or Association Types

3. If you change your meta model - such as by creating new Object Types, Property Types or
Association Types, then you must use the Update Meta Model feature in Evolve Designer to

ensure Evolve is aware of the changes.

Throughout this documentation, when meta model changes are required or are  enforced, the topic is

highlighted in the following way :

@ This feature requires specific Property Types or Association Types for the Objects in question
and therefore may require changes to your meta model.
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Displaying Diagrams in Evolve Sites

This page explains how to display diagrams in your Evolve web pages.

There are two types of diagram that can be displayed in  Evolve web pages:

1. CW Modeler diagrams - any diagram created in CW Modeler in your model .
2. Visualization diagrams - auto-generated diagrams created using Diagram Designer .

Both of these types of diagram can be displayed in either Index Pages or Object Pages

When a diagram is displayed in a page, the objects on it are clickable - but you must have Object Pages for

each of the Object Types otherwise the user will see an error.

On CW Modeler diagrams you can also configure Diagram Popouts Diagram Popouts to display the data
behind objects on your diagr ams in a pop -out panel on the diagram page itself.

f “\ In order to display a diagram in Evolve,  your model must contain a Template Diagram with the

same Rule and Category as the one you wantto  show.

Note: There must be just one template for each Rule/Category combination.

If you try to display a diagram that does not have a corresponding Template Diagram, Evolve will

not be able to show it.

What do you want to do?

Display a CW Modeler diagram in your Site
Display a Visualization diagram in your Site
Display object data with a Diagram Popout

Display a diagram on the home page of your Static Site
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Users, Roles and Access Rights

Evolve Web Platform 2020.0.1 and below:
Users, Roles and Access Rights are only relevant to Dynamic Sites.

Static sites are open to everyone to see who has access to the  URL, and as the data is fixed and

read-only permissions are irrelevant.

If your Site configuration includes Access Rights and Roles, but you want to publish a Static
version of the Site, then those elements are ignored in the generation.

Evolve Web Platfor m 2020.0.2 and above:

Whilst the Roles and Access Rights for the generated content are still operated at generation
time, the gate to access to the site can now be controlled by Evolve Web Platform. This means
that, when Static Authentication is turned on,  users must be given ‘Static' access, at a minimum
to be able to access the site.

If Static Authentication is turned off, Evolve Web Platform will still be required to check the usage
mode, but will then pass through any requests for data, without further authentication.

In order to view an access controlled Evolve Site, a User must log in with a valid Username and Password (or
be given permission through Active Directory or SAML2 group acess). There are three types of User:

0 Static Users - who can access a pre-generated static site. (If Static Authentication is turned off,
anyone with access to the webserver will be admitted).

O«

Social Users - who only have read -only access to data, but can use all the Social features of Evolve
so they can Rate objects, set Favorites, collaborate using Comments and Questionnaires, and can

Share pages with other Users

O«

Contributors - who can do all of the above, but can additionally Edit data as well, and can be
involved in Workflow tasks.

(@]

Diagrammers - who have the same rights as Contributors but can additionally edit and create

Diagrams using eModeler.

All Evolve Sites can have Static and Social Users, however a special license is requi  red to have Contributors
- and the license also controls how many Contributors you can have.

Web Modeler, for example, is a licensed application. Additional licenses are required on a per user basis in
order to use Web Modeler on your Evolve Site.

Controll ing who can see what?
There are two factors that determine which content a User can see in an Evolve Site:

0 Roles - determine which Site pages a User can view
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0 CW Suite Access Rights - determine which objects a User can see, and whether they

can create , read, edit or delete those objects.

NOTE: With Active Directory or SAMLZ2 Authentication and a large number of users, it is likely that
only Roles are used.

Roles

Roles are used to determine which pages within the Site a User is able to view. That means the Menus and
links in the interface are updated to remove all links to pages that the Role determines the User should not
be able to see.

If a page has no Roles assigned to it, then all users in any Role can view it.

As an Evolve Administrator you can create as many Roles as you like, assign Users to those Roles, and then
specify exactly which pages a Role is able to view.

If a User is in more than one Role, Evolve looks at all relevant Roles to see  if the User is able to view the
page.

Roles are also used with Evolve Workflow Evolve Workflow to specify who must approve changes made to
data by other users.

For details on Roles and assigning Users to Roles, see: Working with Roles Working with Roles
CW Suite Access Rights

While the type of User you are (Social User or Contributor) spec ifies what you can do in Evolve, and Roles
control which pages you can see, CW Suite Access Rights and Extended Access Controls are used to

determine what capabilities a User has with specific objects at a granular level.

CW Suite Access Rights can be used to make a User Read -Only, control which Models they can see, and
what they can do with certain types of objects, like ones that are Frozen.

Extended Access Controls can be used to specify whether a User can Create, Read, Update or Delete

objects based on either their Object Type or Category.

CW Suite Access Rights and Extended Access Controls are the final level of access control within Evolve.
Even though a User might be a Contributor, and they can view a Table listing some Processes, they may not
be able to edit all of the Processes listed. They may not even see all the Processes - and another User may
see a different list of Processes.

For full details on CW Suite Access Rights and Extended Access Controls, please refer to the CW Suite

documentation.
Active Directory or SAML2 Authentication

You can configure an Evolve Dynamic Site to automatically authenticate users based on Active Directory or
SAML2 group membership.
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Users authenticated in this way only have to browse to the Evolve URL and they are autom  atically signed in,

without having to enter a username and password.

As an Evolve Administrator, you can state that Users in a specific Active Directory group should be Static
Users, Social Users , Contributors or Diagrammers and you can assign them to an E volve Role, and a CW

Group.
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Running Evolve Designer

Evolve Designer is the application used to create, configure and manage Evolve Sites

(/ ﬁ; \\‘ In order to run Evolve Designer you must log in with a CW user that has System Manager
'\\j | rights.
In addition, certain functions performed by Evolve Designer require that the application is run
with administrator privileges  on your machine.
How to access and run  Evolve Designer

For Dynamic Sites, or Static Sites that are directly published to a web server machine running Microsoft
Internet Information Services (1IS), Evolve Designer must run on the web server itself.

We recommend that you do the following two steps to access and run Evolve Designer:

1. Create a Desktop shortc ut for Evolve Designer .

2. Configure the shortcut to force the application to run with administrator privileges

What do you want to do?

Create a Desktop shortcut for Evolve Designer

To create a Desktop Shortcut for Evolve Designer:
1. Right-click on your Desktop background and select New > Shortcut
The Create Shortcut wizard opens
2. Click the Browse button to navigate to and select evolveDesigner.exe
The normal installation path is C: | Casewise| evolvel Site| bin| evolveDesigner.exe

3. Click Next
4. Enter a name for the shortcut
5. Click Finish .

The shortcut is created.
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Configure Evolve Designer to run with administrator privileges

To configure Evolve Designer to run with administrator privileges:
1. Right-click the Desktop shortcut and select Properties
2. Click Advanced
The Advanced Properties dialog opens

3. Select the Run as administrator check box
4, Click OK

The Advanced Properties dialog closes
5. Click OK
The shortcut Properties dialog closes.

Now, when you click the Evolve Designer shortcut on your Desktop, the program will — run with
administrator privileges.
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Product Licensing

As of the 2020.1.1 release of erwin Evolve Suite / Web Platform, licensing is migrating to the standard Quest
Inc. license system. During the migration, there will be a grace period, whereby existing cu  stomers can
continue to use their existing Casewise licenses. Quest do not intend to force customers onto the new
licensing and will work with them to ensure a successful migration.

If you are considering upgrading to 2022, you should not be concerned with the new
licensing system, as its usage is optional at the moment.

Activating your Quest License

The process for activating an erwin Evolve license is:

1. Support will provide you with one or more license files per  Server machine that requires licensing.

For example:

[E

license.dlv

2. Having installed the software, copy this file to your server's desktop.
3. Double click on the file. You will be presented with a warning:

User Account Contrel

Do you want to allow this app to make
changes to your device?

>
ﬁ' Registry Editor

Verified publisher: Microsoft Windows

Show more details

Yes

4. Click Yes to allow the tool to change the registry.
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License file was imported successfully, To make the licenses in
this file available please log in.

5. The softw are now has the purchased licenses activated on the server. To verify this, load the License
Manager.

Open erwin Evolve suite - Start Here.

erwin | cwsuite

MODEL ANAGE

/ Modeler Maodel Explorer
t Explorer
Matrix

Automadeler

License Manager

Reports information about the state of licenses on the current system, allows
youto request new licenses, and to configure licenses in a multi-user
environment,

Forinomaion weweincon Q) ) @) @

6. Click License Manager , and login.

7. License Manager will show the license code, and various other  attributes.

B License Manager O X
File Records Licenses Help
License Name Producet Version Type License ID Expiry Date
Multi-User database erwin Evolve Suite CM200%.1 Client ClrmégsmadgZ2rmégsm3rmdgsmérade2 Does not expir
erwin Evolve Suite erwin Evolve Suite CM2009,1 Client Clrmégsmadg22rmagsmirmagsmérade Does rot expir
Evolve Web Platform Server erwin Evolve Web Platform CM2009.1 Client Cirmdgsmgdg22rmdgem3rmdgsmdrade? Does not expir
Evolve Web Platform Contributors (1) erwin Evolve Web Platform CM200%.1 Client Clrm4gsmadgZ2rmégsm3rmdgsmérade2 Does not expir
Evolve Web Platform Contributors (1) erwin Evolve Web Platform CM2005.1 Client ClrmégsmadaZZrmiasm3rmdgsmérade2 Does not expir
Evolve Web Platform Offline Generation erwin Evolve Web Platform CM2009.1 Client Clrmdgsmadg22rmaqem3rmdgsmarade? Does mot expir
Evolve Web Platform erwin Evolve Web Platform CM2009.1 Client Clrmdgsmgdg22rmdgsm3rmdgsmarade2 Does not expir
Aute Diagram Designer erwin Evolve Web Platform CM200%.1 Client Clrm4gsmadgZ2rmégsm3rmdgsmérade2 Does not expir
Evolve Web Platform Social Follower (Unlimited Users) erwin Evolve Web Platform CM200%.1 Client Clrm4gsmadgZ2rmdgsm3rmdgsmaradel Does not expir
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Returning your erwin License

If you need to move the license from one server to another, you must contact support, who
will assist with the migration.
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URLSs, File Paths and Directory

Structures

This page explains how the URLs, file paths and directory structures work in Evolve.

Evolve Site URLs

There are three different URLs you can use to access Evolve, depending on how your deployment is

configured.
Accessing the main Evolve IIS Site
The main Evolve /IS Site is only accessible if you use Evolve Dynamic Sites. If you use only

Evolve Static, then this site is still created, but does not display anything.

When you install Evolve and Configure the Server Configure the Server , it creates a top -level Evolve IS
Site.

The Site is used to provide the Evolve login dialog, as well  as to show the page displaying the list of Model

Sites that are available.

The site can be accessed using the following URL:

http://<servername>/<evolvelS-site-name>/

where <servername> is the name of your web server machine, aegcivellS -site
name> is the name yoapecified in the Server Configuration applicatispecified in
the Server Configuration application

Depending on which authentication method your Evolve server is configured to use, when you access the
Evolve IS Site you log on and are then shown a list of all the Dynamic Model Sites you have access to. You

can click any of the Model Site links to visit that Site.
Accessing a Dynamic Site

Dynamic Sites are published at the following URL:

http://<servername>/<evolvelS-site-name>/sites/<sitaurl-name>/

Accessing a Static Site

Static Sites are published at the following URL:
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http://<servername>/<evolvellS-site-name>/statics/<sitaurl-name>/

File paths and directory structures

This section explains the folder structure used by Evolve on the web server machine. The names used are

the default names for a typical configuration.

The Evolve files are typically found at C:\ Casewise \ Evolve

Within this directory, the following directories exist:

Folder

Descript ion

Data

This folder contains all the necessary site -specific files created when you publish a Site.

Includes the following sub directories:

The Common folder contains all resources that are shared across all Dynamic Sites
Common |in Evolve, such as translated text and Site logos.

Logos for Model Sites listed on the top -level Evolve Site are also stored here.

The Sites folder contains a folder for each of the Dynamic Sites that are published.

Sites Each of these directories is named according to the  Site ID in the deployment

settings for the Site, and contains the css, js, images and webdesigner sub
directories.

Stati The Statics folder contains a folder for each of the Static Sites that are published,
atics
which in turn contain all the published files  and resources for the Site.

Site

Contains all the application files required for Evolve to run.
Also is the home of the custom folder used to store customizations such as js, css, themes and
images.

Log files.

Content

This folder will only exist if you have had a previous version of Evolve on the machine.

Static

This folder will only exist if you have had a previous version of Evolve on the machine and had a
Static Site published.

Accessing object pages directly by the URL

There are two ways to access content directly in Evolve using URLSs.

The Standard URL

Using the 'Share' button:
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@,

Will allow a user to share a page with another user. It is also possible to gain the same behaviour by copying
the address bar URL from your browser and sharing this ~ with other users. These URLs are model and site
dependent. This means that they will only work for a given site, generated by a given model. This is because
the identifier for the object is an ID that is local to the model. This is normal, and in almost a Il cases, is
exactly what is required.

A sample of a Standard URL.:

localhost/evolve/sites/voxdnoev/index.html#/cwtype=single&cwview=process&lang=en&cwi
d=1767

Where: cwid= 1767 is the local ID for an object.

The UUID URL [Evolve 2016.1.1 and above]

A UUID based URL differs in the way that it identifies objects in Evolve. AUUID  URL is still site dependent,
in that the first part of the URL identifies the Evolve web site, however the latter part can be used with any

site that supports the given object type, an d has an object with the matching UUID. This means that objects
which have been copied, or transfered by XML (or other means) from one model to another, will still be
considered to be the same object.

A sample of a UUID URL:

localhost/evolve/sites/voxdndienex.html#/cwtype=single&cwview=process&lang=en&cw
uuid= f0a9ed615e7b11e48273a08869a4da20

Where: f0a9ed615e7b11e48273a08869a4da20 is the UUID of the object.

How does this work?

When you access a URL using the cwuuid, Evolve will do a lookup in the model a nd redirect the page to the
matching cwid.

If both cwid and cwuuid are supplied in the URL, Evolve will ignore the cwuuid parameter.

Why might UUID based URLSs be useful?

Take an example where you are running a master model in English, and take copies of this model to
translate into French. You want to add the ability to reference the translated object from the English object.
However, the IDs of the objects within the French model, may differ f  rom those in the English model. It is
therefore not possible to create a simple reference.
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In this instance it is possible to use the UUID based URL. You can simply take the site portion of the French
URL, and add the Object UUID from the English URL, and you have a new URL that can jump from French to
English.

NB: To find the UUID of an object, either display this in your Evolve site design, or if you are developing a
custom view, look to the JSON data structure that is returned by the Evolve server.
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Creating your First Evolve Site

If you are new to Evolve, once you have familiarized yourself with the  Key Concepts Key
Concepts , Metamodel Considerations  and how to Run Evolve Designer ,Run Evolve Designer , you can
use the following pages to help you get your first Site up and running.

Once you have completed these tasks, you should have a simple working Site containing all the fu ~ ndamental
elements. Only once you have done this do we recommend that you go on to try different options.

1. Configure your server

2.Create a Site

3. Create a basic Index Page displaying a simple list of objects
4. Create a simple Object Page

5. Create a Menu to link to your Index Page

6. Publish your Site

7.0nce you have published your Site and tested that it works, you can go on to explore
how to extend your Site by creating more adventurous pages using the information in
the Layouts and Behaviord.ayouts and Behaviorssection.

Important factors to remember when extending your site

As you go on to add more content to your site, remember these important factors.

0 You must create an Object Page for each type of object you want fo view.

0 Your CW model must contain  a Template Diagram with the same Category and
Rule combination for every Diagram you want to display — in Evolve.

This must be one template only for each Category and Rule - if you have multiple
templates then Evolve will report an error.
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Creating Sites and Pages

Create a Site

Before you can create a Site, you must ensure you have completed the configuration of your
Evolve Server.

See Configure your Server for details.
These instructions explain how to set up a basic, empty Site, and then how to configure the deployment
settings so that it can be published.

Once the Site is created, you should follow the instructions in the rest of the help to learn how to create Index

Pages, Object Pages and a Menu Menu .

An Evolve Site is explicitly linked to one CW Model. You can create one Site in each Model in your reposi  tory.

Creating a Site makes changes to your Model's meta model, resulting in new Object
Types and Associations being added to the Model.

If you are using Evolve for the first time and want to experiment with creating a Site, we
recommend that you create a copy of an existing Model and use that as the basis of

your Site.

Step 1 - Create a Site in your Model

To create a Site in your Model:
1. Run Evolve Designer
2. Select the Model you want to create a Site in
The page updates to show Sites in your Model.

If your Model is not listed, you must enable it to support having an Evolve Site. To enable your
Model :

i. Click the plus ( +) icon in the top -right of the dialog .
A pop-up menu listing all the models in your repository is  displayed.

ii. From the pop -up, select the Model you want to use for your Site
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Your Model's meta model is updated with the new Object Types and Association Types required
for Evolve. This process may take a few moments .

Once the Model is updated, an icon repre senting the Model is displayed in the Evolve Designer

window.

3. Onthe Sites page, click the (+) icon in the top  -right of the dialog .

The New Site dialog is displayed .

4. Enter a Name for your Site in the Site Name field

5. Click Create .

Step 2 - Configure the Site settings

To configure the Site settings:

1. In Evolve Designer click the top Site node .

2. Review the following settings:

Setting Description
Site o . )
Choose the language of the Site if you want to override the global Evolve  setting.
Language
Select 'None' (default), '‘Comma’ or ‘Space' to specify which number separator is used
when displaying numbers on your Evolve Site.
Number For example:
Separator None - 1000 or 1000000
Comma - 1,000 or 1,000,000
Space - 1 000 or 1 000 000
Less Theme Choose the theme of the Site if you want to override the global Evolve setting.
Static Sites only
E . Use this option if you are publishing your Site in Static mode and you are showing
Xpor
. P Diagrams created in CW Modeler using the CW Modeler Diagram behavior.
Diagram
Images You can leave this option unselected if you are not displaying diagrams or are only

using the Vector (HTML5 ) behavior to prevent images of diagrams being generated

when you publish your Site - a process which can take some tim e.
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See the Evolve Configuration ReferenceEvolve Configuration Reference for details on the f ull list of
settings.

3. Select the Deployments > [server name] > Model node (showing the Scriptname of the Model
your Site is in) .

The settings are shown in the right -hand pane

4. Complete the following fields:

Setting Description

Specify the name of this Model Site as it appears in the URL, such as
http://<server -name>/<evolve -IIS-site-name>/[sites|statics]/<  site -url -

name >/

Site URL Name . .
Ensure that the name is all lower-case and has no spaces or special characters.

To change the Site URL Name for an existing Site, see: Change the URL Name

of your Site .

Site Display | Enter the name of your site. This is only displayed on the top -level Evolve Sites
Name page.

Dynamic Deployments Only

This control now replaces the single mapping per license type, allowing a much
greater level of control of groups.

The control is used for both Active Directory and SAML2 configurations.

AD Group - is used to specify the name of th e Active Directory group you want
to use for this configuration. It is also used for the name of the "Outgoing Claim
AD Mapping Type" in a SAML2 configuration.

If a user is a member of this AD Group or Claim, then they will assume the
permissions indicated on this ro w of the table. If a user is a member of multiple
Groups or Claims, then they will receive the aggregate of the permissions, with
the exception of CW User Type, which will be promoted to the highest license

type they are allowed.

Dynamic Deployments Only - this can be one of "Social, "Contributor",
"Diagrammer".

AD Default | Dynamic Deployments Only
Social Role | Only used if the Evolve Authentication Method is set to Active Directory.

Name Specify the default Role you want newly created Evolve Social users t o be given.
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Dynamic Deployments Only

AD Default . o . ) )

. Only used if the Evolve Authentication Method is set to Active Directory.
Contributor
Role Name Specify the default Role you want newly created Evolve Contributor users to be

given.

Display Model | Applies to Dynamic Sites only.

in Evolve
Use this option to specify if this Model Site is available or disabled in Evolve.

See the Evolve Configuration Reference for details on the full list of settings.
5. Save the Site.
The settings are complete.
Step 3 - Publish your Site
Now the Site and IIS are configured, you must publish your site so that all the required files are generated and
placed in the correct location on the web server.
To publish your Site:
In Evolve Designer, click Dynamic Site or Static Site in the Publish area on the Home menu.
All the Site's files are generated in the correct location for the web server to host them.

The status area at the bottom of Evolve Designer updates as the various processes involved in
publishing are performed. Once the operation is complete, it reports 'Site generated in'.

These instructions are for publishing your Site for the first time - there are different publishing
options for when you are edjting a Site that has already been published. See  Publishing your

Site for full detai Is.See Publishing your Site for full details.
Accessing a Dynamic Site

You can access a Dynamic Site at the following URL:

http://<servername>/<evolvellS-site-name>/sites/<sitad>/

Accessing a Static Site

You can access a Static Site at the following URL:
http://<servername>/<evolvellS-site-name>/statics/<sitéd>/
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Layouts and Behaviors Explained

Evolve offers many differ ent possibilities for how you want the information in your  Index Pages and Object
Pages to be displayed.

These display options are controlled by Layouts and Behaviors .

Layouts control the physical structure of the web page, whereas Behaviors control how th e data is
displayed inside the Layout. Some Behaviors can only work with certain Layouts. Additionally, some Layouts
and Behaviors can only be used on Index Pages, while others can only be used on Object Pages. However,
some can be used on both.

Use the ta ble below to see all the page display options available in Evolve, then follow the links to find out
how to create them in your own Site.

There are a number of different options for how you want to  display the properties of ob  jects
on Object Pages . For full details on these display options see:

Working with Property Groups and Property Group Layouts

Page Display Options

Type Example Description Editable? | Used in

The Simple List is the default Layout

for all new Index Pages and displays
Index

Pages
Object
Pages

=X objects in a simple bulleted list.
Simple List On Object Pages this layout is used to | NO
show related objects such
as Associations or Diagrams the
object appears on

An Accordion is an Object List where
each object reference is clickable and
can be expanded to show further
information about the object - either

Index

Accordion properties of the object, or associations. No

Pages
When you use an Accordion, you can

nest other Layouts and Behaviors inside
it, such as another list of Associated
Objects.
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Table
(Complex)

A Table (Complex) behavior displays
objects and properties in table format.
You can choose which properties to
display as columns, and you can include
associati ons.

Users can sort the list by clicking
column headings, and they can
optionally edit objects directly in the
Table itself.

Yes

Index

Pages
Object
Pages

Table
(Simple)

The Table (Simple) layout creates a
basic table for displaying lists of data,
with the ability to open the Object Page
for a listed item.

No

Index

Pages
Object
Pages

Simple
Matrix

A Simple Matrix creates a table which
displays Associated Objects for the
object in question, and shows which
other similar objects these Associated
Objects are associated to.

For example, you could show which Risk
objects your Process is associated with,
and which other Processes are

associated with those Risks.

No

Object
Pages

Tabs
based on
Lookup
Values

This list -type display organizes your
objects into groups  based on the value
of Lookup properties (drop -downs such
as Category ).

Vertical tabs on the left side of the page

are used to represent the values, while
the objects themselves in each tab are

displayed in simple lists.

Option

You can optionally include an Overview
Chart which creates an 'Overview' tab
displaying a Pie Chart showing the

proportion of each value.

No

Index

Pages

erwin Evolve 2 User Help Guide |

Creating Sites and Pages |



https://dzf8vqv24eqhg.cloudfront.net/userfiles/1621/2466/ckfinder/images/evolve/layouts/grid.png
https://dzf8vqv24eqhg.cloudfront.net/userfiles/1621/2466/ckfinder/images/evolve/layouts/simple-table.png
https://dzf8vqv24eqhg.cloudfront.net/userfiles/1621/2466/ckfinder/images/evolve/layouts/tabslookup.png

The Pie Chart based on Lookup
Values display creates a chart for a
specified Object Type showing the

Pie Chart percentage of objects with values from
based on one Lookup (drop -down) property. No Index
Lookup o Pages
Values Th? chart .|s identical to the
optional Overview Chart offered by
the Tabs based on Lookup
Values display.
A Recursive Pie Chart allows you to
show a top -level chart which sums the
values of properties of associated Index
Recursive . objects (or Intersection Objects), and No Pages
Pie Chart then allows users to click those items to Object
view a second chart showing all the Pages
objects associated to the selected
object.
. Index
A Roadmap is a type of Gantt Chart that Pages
Roadmap enables you to show a number of |No Object
objects and their start and end dates .
Pages
A Lifecycle Roadmap is a type of Gantt
Chart that enables you to show a
Lifecycle __'———__;—_ number of objects , displaying their No Index
Roadmap ___——: overall time frame, as well as Pages
highlighting in different colors any
number of phases of their lifecycle .
A Cost/Benefit Chart enables you
to compare  properties you class
Cost . as Costs in your organization against
Benefit _ properties you class as Benefits . No :2;;
Chart The result is a chart that allows you to
evaluate your expenditure in terms of
business importance.
Simple Bar The. Simple Bar Chart behavior displays Index
Chart a simple bar chart on your Index Page , | NO Pages

listing a maximum of 20 objects on
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the yaxis and referencing a

simple number property on the xaxis.

On your Index Page , the Multi - Axis Bar

Multi-Axis Chart behavior displays a simple bar N Index
o]
Bar Chart chart which compares the values of two Pages
properties of the objects referenced.
Simple Bubble Charts allow you
. oy to compare objects of the same type,
Simple .
: H by analyzing three levels of data and Index
Bubble e st . _ No
Chart = using the values to affect the size and Pages
ar position of the representations on the
chart.
Cluster Bubble Charts are similar
Cluster —_— to Simple Bubble Charts, except they nd
ndex
Bubble 3 allow you to visualize the properties of No b
ages
Chart an Associated Object (directly or 9
indirectly), or an Intersection Object
The Visual Identity layout is used to
show a list of objects with visual
indicators to represent some of their
properties.
Index
. The layout displays each object as a
Visual Pages
. rectangle, and then at the bottom of No
Identity . Object
each shape you can show icons
Pages
to represent the values of one or more
properties of your object.
The Visual Identity layout requires
a Custom Site deployment.
The External Picture layout can be
used to display animage , stored on the Index
External m H [_] Evolve server, which is referenced as a Pages
. - . No
Picture I"aj' property of an object Object
The External Picture layout requires Pages
a Custom Site deployment.
The Image Layout is used to display an Index
Image _ ge hayot dlodispiayan |\,
image for an object that is referenced Pages
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using a Single -Line Object
Text or URL Property. Pages
It is used on its own, not together with
other properties, so suits larger images
more.
Vector Maps enable you to highlight Index
countries or places on a map  so that Pages
Vector Map . No _
the user can click through to see more Object
detailed information aboutt hat area. Pages
The Radar Layout is used to display
and compare three or more properties of Ind
ndex
an Object, or many Objects, in one
Pages
Radar chart. No
. . . Object
It is used on its own, not together with
. ) ) Pages
other properties, so suits larger images
more.
Index
. Pages
View Box Layout reserved for internal Evolve use. | No
Object
Pages
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Working with Index Pages

Index Pages Explained

Index Pages are the top -level pages in your Site. They are generally the starting point for  users browsing your
Site. For navigation purposes, in order to view an Index Page it must be linked to a Menu.

Index Pages essentially display lists or representations of objects which can be expanded on by supporting
Object Pages which show more informati on about the object in question.

So users typically find objects they are interested in on Index Pages and follow links to Object Pages providing
more detail.

Index Pages are generally tied to a specific Object Type, but you can have multiple Index Pages p  er Object
Type.

There are three types of Index Page:

1. Object listing pages , such as lists, grids, and accordions
2. Graphical pages , such as bar charts, maps, pie charts and roadmaps
3. Diagram pages , showing CW Modeler diagrams or visualization diagrams.

What do you want to do?

Create an Object List Index Page

Create an Empty Index Page

Create a Diagram Index Page

Create a Graphical Index Page

Use Tabs to organize content on an Index Page
Create Multiple Index Pages for an Object Type

Extend display options with Layouts aad Behaviors
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Create an Object List Index Page

The instructions on this page detail how to create a basic Index Page which displays a simple list of objects.
This is the default display setting for all new Index  Pages.

Basic Object List Index Pages only display the Name of the objects listed within them.

While these instructions describe how to create a basic Object List page, Evolve offers many
different options for how you want to  display content in your pages.

To find out more about these different display options and how to configure them, see Working

with Page Layouts and BehaviorsWorking with Page Layouts and Behaviors.

Creating a basic Object List Index Page is a two -step process. Follow the steps below.

Step 1 - Create the page

To create a new Index Page:
1. In Evolve Designer, expand the Site node.
2. Right-click the Index Pages node.
3. Select Add Index Page for Object Type
4. Scroll through the pop -up list to select an Object Type to base the Index Page on

The new Index Page is created and is placed at the bottom of the list of Index Pages in the tree. It s

given a default name of index_<object -type -name> .

If you close and reopen Evolve Designer, then the new page will be listed alphabetically.

Step 2 - Specify the page properties

Once you have made an Index Page you should configure its properties.

To specify the page properties.
1. Select the node for the Index Page

The right -hand panel shows the properties for the page

2. Edit the page's properties:
0 Use Page Name to specify the name of the page as it appears in the URL.

Please note you can only use lower case letters with no spaces.
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(Y \ The Page Name must be unique , but generally you can leave it as the default. The only time you
- will need to edit the Page Name is if you have more than one Index Page pe r Object Type.
See Creating Multiple Index Pages for an Object Type for more information.Se e Creating
Multiple Index Pages for an Object Type for more information.

If you change the Page Name and you already have a Menu linking to the page, you must
also change the Menu Link as it is not updated automatically.

0 Use Page Display Name to set the name of the page as it appears in Evolve web pages, in
Menus.

o Page Title is not available for index pages.

o0 Use Add Page Filter to specify if you want the filter control available on the page - so a user
can filter the displayed list of objects.

o Use Has Image to specify the image and styling to be used when the page appears in a
menu.

Selecting Has Image enables the following properties:

A Use the Custom Image drop-down list to select an icon to be displayed
alongside the Page Display Name in the published web pages. These icons are
part of the Theme applied to your Site.

A If you chose a Custom Image, use Apply Color Transformation  to specify the

color transformation to the icon

A If you chose to Apply Color Transformation, select the color to use from
the Color Transformation  drop-down list

A To apply a hover effect to the icon, use the Apply hover effect to the
image check box.

3. Save your Site.

The Index Page's properties are saved.

0 )
(') Remember that to view your page you must have a Menu which links to it.
&= A

See Create and Edit a Menu for more details.

Related Topics

Use Page Queries and Filters to display just the objects you want
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Use Tabs to present your data
Use a CustomDisplay String to show more than just the object Name

Display your data using different Layouts and Behaviors
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Create an Empty Index Page

The instructions on this page detail how t o create an empty Index Page that is not linked to any Object Type.

You might want to do this if you are creating some of the more complex page types, such as Cluster Bubble

Charts Cluster Bubble Charts  and so on.

Once you have created the page, you can then add an Object Type node, a Tab Controller, or both, depending

on what the behavior behavior you plan to use requires.
What do you want to do?

Create an empty Index Page

To create an empty Index Page.
1. Right-click on the Index Pages node and choose Add Index Page .
A new Index Page node is added to the bottom of the list of Index Pages

2. Select the new Index Page node and edit its settings accordingly, particularly Page Name and Page
Display Name
o Use Page Name to specify the name of the page as it appears in the URL.

The page Name must be unique and can only contain lower case letters, numbers, dashes  and

underscores, with no spaces.
If the Page Name is not unique, or it contains illegal characters, you will see an error when you try

fo Save the Site.

0 Use Page Display Name to set the name of the page as it appears in Evolve web pages,
such as for its title or in Menus.

3. Save your Site.

Remember that to view your page you must have a Menu which links to it.

See Create and Edit a Menu for more details.
Add an Object Type node to an empty Index Page

To add an Object Type node to an emply Index Page:
1. Right click the Index Page node and choose New Object List > [object -type]

Where [object -type] is the name of the Object Type you want to add.
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An Object Type node is added to the Index Page.

2. Save your Site.

Add a Tab Controller to an empty Index Page

To add a Tab Controller to an empty Index Page:
1. Right-click on the Index Page node and choose New Tabs Controller
A new Tabs node is added .

2. Save your Site.

Related Topics

Use Page Queries and Filters to display just the objects you want
Use Tabs to present your data
Use a CustonDisplay String to show more than just the object Name

Display your data usng different Layouts and Behaviors
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Create a Diagram Index Page

A Diagram Index Page is used to display either a single CW Modeler diagram, or a Visualization diagram.

Shapes in the diagram are clickable, linking through to the relevant Object Pages for the Object Type selected.

AR
(0 ) | In order to display diagrams in Evolve Sites, you must ensure you have a template  diagram in your

model which has the same Rule and Category as the diagram you want to display.

If you do not have an equivalent template diagram, the diagram will not be able to be displayed.

What do you want to do?

Display a CW Modeler Diagram on an Index Page .

‘/“' "\\ . . .
| | || These instructions assume you know how to Create a basic Object List Index Page.These

instructions assume you know how to Create a basic Object List Index Page.

To display a CW Modeler Diagram on an Index Page:

1. Create a new Index Page for the Object Type ' Diagram '.
2. On the 'Diagram ' node, use the Filter Properties area to specify exactly which diagram you want to

show.
We recommend you use the ID property as the reference and specify the ID of the diagram you warnt.

Remember that any properties you reference in the  Filter Properties area should also be selected in
the Selected Properties area.

3. Right-click the Layout node and choose Switch Layout > CW > Diagram .

4. Right-click the Layout node and choose Add Behaviors > CW Modeler Diagram

5. Onthe CW Modeler Diagram node, use the Full Screen setting to specify that the diagram is displayed
in full -screen mode.

6. Save your Site.

PN

| U )| Ifyou plan to publish your Site as a Static Site, you must ensure you use the  Export Diagram

Images option on the Site node settingsSite node settings toensure images of your diagrams
are generated.
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Create a Graphical Index Page

There are several different display options for graphical Index Pages, inclu aing:
0 Pie Charts (including Pie Charts based on Lookup Values and Recursive Pie Charts) .
0 Bubble Charts .

0 Bar Charts - Simple (Limited) and Multi -Access.

0 Roadmaps - Basic and Lifecycle .

0 Cost-Benefit Chart .

0 Vector Maps for displaying locations .

Each of these different types of Graphical Index Pages start out as basic Index Pages.

erwin Evolve 2 User Help Guide |
Creating Sites and Pages |



Create Multiple Index Pages for an Object

While Index Pages are typically linked to a specific Object Type, you are not restricted to having just one page
per type.
Evolve allows you to create as many Index Pages as you want for any given Object Type.

You might do this to have different Index Pages for different Categories of an Object Type, or to display only

those objects associated with another object.
You can then use Sub-Menus to link to link to the different Index Pages you have.
If you do want to use more than one Index Page for an Object Type, there is  one important factor  you must
be aware of:
The Page Name of an Index Page must be unique .

When you create ad ditional Index Pages for an Object Type, the default Page Name is always the
same -index -[object type name] , such as index -process .

You must ensure that you give a unique name to each page to avoid any confiicts.

When editing the Page Name, you can only us e lower case

letters , numbers , dashes and underscores , with no spaces.
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Working with Object Pages

Object Pages Explained

An Object Page is used to present the details of an Object Instance - a web user selects the object on an
Index Page or Diagram, and the Object Page displays its properties.

You must have an Object Page configured for each type of Object you want to see the details of in your Evolve
Site.

You can organize the information presented in an Object Page into  Tabs Tabs, and you can present different

views of the data using Object Page Views Object Page Views .

In addition to just an object's properties, Object Pages can be used to display Diagrams - both Visualization
Diagrams and standard Diagr ams that relate to the object - as well as Associated Objects in Lists or Tables.

What do you want to do?

Create a new Object Page
Create an Object from a Grid
Present your data using Tabs

Offer different perspectives with Object Page Views
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Create an Object Page

An Object Page is used to present the details of an Object Instance - a web user selects the object on an
Index Page or Diagram, and the Object Page displays its properties.

You must have an Object Page configured for each type of Object you want to see the details of in your Evolve
Site.
You can create more than one Object Page per Object Type. Additional Object Pages you create

for an Object Type are displayed as Views.

For more information about creating multiple O bject Pages as Views, see. Object Page

Views Object Page Views .

Important: You can only display an individual Prope rty Type, or an Association Type, once onan

Object Page, including across Tabs.

Creating a basic Object Page is a multi -step process. Please follow the steps below.

Step 1 - Create the Page

To create an Object Page:

. In Evolve Designer, expand the Site node.

. Right-click the Object Pages node.

. Select Add Object Page for Object Type

. Scroll through the pop -up list to select the Object Type the Object Page represents

A W N P

The new Object Page is created and is placed at the bottom of the list of Object Pages in the tree. It is

given a default name of <object -type -name> .
If you close and reopen Evolve Designer, then the new page will be listed alphabetically.
Step 2 - Specify the page properties

Once you have made an Object Page you should configure its p roperties.

To specify the page properties.
1. Select the node for the Object Page .
The right - hand panel shows the properties for the page

2. Edit the page's properties:
o0 Use Page Name to specify the name of the page as it appears in the tree in Evolve
Designer. Please note you can only use lower case letters with no spaces
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| | We recommend you do not change the Page Name , unless you are creating an additional Object

Page for the Object Type to actas a View View - in which case you must give it a unique name to

avoid a confiict.

0 Use Page Display Name to set the name of the page as it appears in Evolve web pages,

such as in the menu of Views Views .
0 Use Page Title to setthe name of the page as it appears in E volve web pages, as the title of

the Page. Introduced in version 2018, it has possible to use a Custom Display String, to
Title.

format the

® o0
Evolve Designer (Test » TEST) - v201800.0

Add Page Fite

Customzed Page

3. Save your Site.
The Object Page's properties are configured and saved.

You have now created an Object Page, but it will not yet display any content.

Step 3 - Show some content

The instructions here explain how to insert a simple Property Group displaying the basic
properties from the ‘General’ Pane of the object. Object Pages can display much more than this

simple element.

You can also use Tabs Tabs to display more content on Object Pages, including Object Lists for

Associated Objects, rather like you would on an Index Page.

The simplest way to display some content is to show some properties of the Object being viewed.

You do this by inserting a Property Group .

To insert a simple Property Group:

1. Expand the node for the Object Page
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2. Right-click the Object Type Name node, for example 'Process’, and choose New Property Group >

From CM Panel > General
A 'General' node is added beneath the Object Type Name node.
3. Save your Site.
The Object Page is saved.
To read more ab out Property Groups and how to use them, see \Working with Property Groups  Working

with Property Groups
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Creating Objec ts from an Object Grid Using
Object Pages (4.0.2 onwards)

You can new create objects in an Object Grid by utilising an existing Create  Object page.

7o do this:

1. Check the Add Object box
2. Check the Use Object Page For Add box

3. Inthe Create Object Page Name, select the Object Page from which you wish to generate additional

objects.

Layouts Options [cwWebDesignerTreeNodeBehaviourKendoGrid] - Table (Complex)
ER S -

=N Node Name Table (Complex)

B-4) Index Pages

- | ] index_applications Add Object
= o Application -
e E Layout Empty Use Object Page For Add

=t Table (Complex)

i Create Object Page Name
O Application - Organisation ()

application
index_applications_gridwithtab Edit Object
[ index_app -9 )
D index_applications_inlinegrid_with_association
D index_applications_inlinegrid_without_association EditMade Popup

D index_cw_views

Delete Object
- | ] index_diagrams

D index_diagramsa.

Unlink Object O
- [ ] index_entities

[l index locations

Intersection Object Grid
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Object Page Views

Just as you can have Multiple Index Pages for one Object Type ,you can also have multiple Object Pages for
an Object Type.

When you have more than one Object Page for an Object Type, itis calleda View.

You can use Views to offer a different perspective on the object in focus, per haps showing a different set of
properties to the default page, or show the object in context, based on its relationships to other objects.

When a user views an Object Page, the default page is the one which has a Page Name matching the Object
Type name , such as 'process' for the Process Object Type. Any other pages, or Views, are displayed as links
in a menu above the page title, so the user can click them to view the pages.

Creating Object Page Views

To create an Object Page View , simply create a new Object Page  for your Object Type - in exactly the same
way you would for any Object Page.

However, you must make sure your new Object Page has a unique Page Name - you cannot for example
have two Object Pages titled 'process’, so you should rename the new one so that it is different.

In every other respect, creating an Object Page View is the same as creating a standard Object Page.
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To view the list of Object

Associating Non-Diagram Object s

add, update and delete multiple associated objects
Evolve Designer.

1. Start Evolve Designer.

and their properties in

Types displayed in the Diagram Popouts

2. Click a model. For example, EA Foundation 2 Sample Model .

3. Click Site.

You can associate any object with another object that is not part of the diagram. Additionally, you can view,
erwin Web Modeler by configuring

4. Expand Site > Object Pages .

Publish dministratio

Home Dynamic Deployment Static Deployment
— ! t } = @
H P e |

Layouts Options [cwWebDesignerTreeNodePage] - process
=-§% Site A
X Page Name
{) Index Pages process
5-((C) Object Pages Page Display Name Process
& AJapphcatm
Page Ti
-] attribute 2geTite
&[0 businessrule Page Type single
& I,]cw_uaer_favonites
) datastors Add Page Filter
: %::i:;m Comomasapae
i ? entity boom Library Evolve Icon Library ~
H ] eventresult
-] flow Icon Color WGreen -
¥ r] indicator
= "
5. Right-click diagram and click Expand All .
Layouts Options [cwWebDesi|
=-(C) Object Pages L Page Name|
3 I] application
+ ﬂ attribute Page Display N
+ A] businessrule
: PageTitle
[+ 1 cw_user_favorites
® x] datastore Page Type
- ) A ‘
3 | @ Expand k
+ F‘] docume,
< [o ExpandAll |
3 entr
"j 1y 2 Collapse L f
L eventres Generate Content - Static Mode Only
X A:] flow J % Delete )
e[ 1)) indicat | 1 Duplicate
=N £y ilaialahaliaid

6. Click Corporate Modeler Diagram
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Layouts
& Jﬂ businessrule
r‘D cw_user_favorites
® "D datastore
:}J diagram
= O Diagram
58 Layout Object Page
== Tabs
= . View
=58 Layout Diagram
E Corporate Modeler Diagram
=4 Properties
E2 General

S8 Description

The list of Object Types appears under Diagram Popouts.

Options [CwWebDesignerTreeNodeBehaviourCMDiagram] - Corporate Modeler Diagram

Node Name I{Corporate Modeler Diagram
Full Screen
Default Zoom | F\t v
Diagram Popouts - =
ObjectType  Category Diagram P. eModeler E...
Process v|_|Undef... v |process_... v
Role v|_|Undef . v|role_dia.. v
Service v|_|Undef.. v |service_.. v
Technol... |v|__|Undef.. v |technolo... v
» Data Store |v|__|Undef... v datastor.. v
. v v v 0 v
To create a n Object Type Associatio n:
1. Start Evolve Designer.
2. Click a model. For example, EA Foundation 2 Sample Model .
3. Click Site.
4. Expand Site > Diagram Popouts > application_diagram popout > Application

5§ Site ¢
+ (/ Index Pages

, (4;," Object Pages

‘;‘, Template Nodes

) Menu
Deployments
@ Diagram Popouts ¢
application_diagram_popout <=
=] O Application K1
58 Layout Diagram Popo

a9

83 General

o ja) . .
55 Description

S5 Details

5. Right-click Application and click New Association > Technology > Application

2 Technology ()
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= v ¥
=-£1) Diagram Popouts CWTask N
application_diagram_popout CW User »
= 8 Expand Data Store J
a
S3E L Expandall Diagram C
B85 Gen Diagram Draft » "
i 3 Collapse - Bge Rating
88 Des New Tab Controller ohy * Bory
BB Det2 5 New PropertyGroup  » TT'°P“’ | '
o (D TecH [ NewRssodston Tw]  TPorole ’ pet
tt vl Delete - '
Location »
ages Organization »
) Info(3) Success(o) Warning (o) Error(o) ClearA Process »
ently running with elevated privileges - Update Meta Model Project »
Hing Site node details
Si
Hing Site node details completed s -
Technology 3 Application - Technology ()

You can add any Object Type Associations.

6. Click Application

2 Technology () node.

& @ Diagram Popouts

=] O Application

o

S5 General

jo= o] . .
S5 Description

S5 Details

=~ || application_diagram_popout

£1 Layout Diagram Popout

| - Application-Technology()l

7. In the Node Name box, replace -Application 2 Technology ()° with —Technolo gies®.

Cptions [cwWebDesignerTreeNodeObjectModeAssaciationType] - Application - Technology ()

MNode Name

Application - Technology ()

Association Type To
Target

Application - Technology ()

Target Object Type

Technology

8. Optional: If you want the diagram user to be forced to have at least one associate object, then

the Mandatory Association

check box.

Options [cwWebDesignerTreeNodeObjectNodeAssociationType] - Application - Technology ()

MNode Name

Application - Technology ()

Assaciation Type To

Application - Technology ()

Target
Target Object Type Technalogy
Mandatory Association
i O
ObjectGroup ID technology_10929_480077938
SortOn

Mame

A Set Mandatory Association pop -up appears.
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Set Mandatory Association X

Checking this box will prevent users from creating objects in the grid,
as they will be unable to create objects and associate to them
simultaneously

9. Click OK.
10. Click Save.
11. Click Dynamic Site .

The Associated Objects are now visible in the diagram.

To view the Associated Objects in the diagram .

1. Open the browser and login to erwin Evolve Web .
2. Click a model. For example, EA Foundation 2 Sample Model .
3. In the left pane, click Application .

4. Click Application Architecture

5. Click the required object for which you wantto  view Associated Object. For example, Salesforce .
The Associated Objects Types are now visible in the right pane.
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To add Associated Objects in erwin Web Modeler .
1. Click the Edit Diagram In Web Modeler icon.
Application Architecture 9 B E A

Production & Content

[ Partrer Aeiationthip Managemant

Delvary & Steck

Product Management

=5 R =
P =] — e i
= = | B ==

2. Click Create new draft
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Available drafts for this diagram

Application Architecture

Created by : Administrato

Application Architecture
Created by : Adminiztrats
Last Saved : February 24, 2023 17:51:56
Application Architecture

Created by : Administrata

Last Saved : February 24, 2023 16:39:5

©0
@O0
00

The erwin Web Modeler editor opens in the new tab with the predefined Shape Palette of the

selected template .

3. Select the object for which you want to add Associate d Object. For example, Salesforce .

li?i .

The Object Associations list appears.

4. Click

Object Associations

o Technologies v

5. Click the Technologies drop-down list.
6. Click Add Associated Object

Associated Objects pop -up opens.

Associated Objects

Object Type

Category

Object v

Cancel Save

The Object Type field is pre -populated with the Object Type to which you want to add an

Associate d Object.

7. Click the Category drop-down list and select the required option.
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8. Click the Object drop-down list and select the required option.
9. Click Save.

10. Click t .
11. Click Confirm Publish

Once the diagram is published in the erwin Web Modeler, you can access it from the Modeler in the
erwin Evolve Suite.

Mandatory Association

Mandatory Association enforces you to add at least one Object Association.

If no Associated Object is added, a pending task appears in the To -do List and the Publish Diagram is

disabled.

To add Mandatory Association

1. Click @,
To-do List opens.

To-do List o
>

Mandatory Technologies
o association required

i Mandatory Technologies
=B association required

2. Click the pendingtask. F or e x aMapdatery Technologies association required o,

Once pending task selected , the object is selected automatically, and the Object Association section

appears in the right pane.

Object Associations

>

[ ] Technologies

Front Office
Partner Relatic+ship Management Customer Relationship Management @
Sartner Accelerator + 4 Syscom (7} el o
@ @

\ r @
.I

3. Click the Technologies drop-down list.
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Object Associations

o Technologies W

4. Click Add Associated Object

o Technologies <

. - ] Mo associations

o + Add Associated Object

The Associated Objects pop -up opens.

Associated Objects

Category - Object v

Cancel Save

The Object Type field is pre -populated with the Object Type to which you want to add an
Associate d Object.

5. Click the Category drop-down list and select the required option.
6. Click the Object drop-down list and select the required option.
7. Click Save.

8. Click t .

9. Click Confirm Publish .

Once the diagram is published in the erwin Web Modeler, it can be accessed fro m the Modeler in the

erwin Evolve Suite.
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Working with Menus

Create and Edit a Menu

The Menu appears on the left -hand side of your Evolve web pages and links to pages you have created in
your Site.

However, you must add the links in the menu yourself, giving you full con  trol over how they are displayed
and in what order the menu items appear.

You can add menu links to the following items:

O«

Index Pages.

O«

Create Object pages (Dynamic Sites only) - Object Pages that allow users to create new objects.

Administration Pages (Dynamic Sites only) - either for viewing administration data such as Roles,

O«

Questionnaires and so on, or as Create Object pages to allow users to create new objects of these

types.
/‘// \\
| | )| Touse a Create Object page in your Dynamic Site, you must have  created an Object Page or
N~ Object Page View in advance, and you must make sure that the Object Page is configured using
Property Groups to display all the properties that the user must enter - Including
all mandatory properties.
Menu levels

The Menu in Evo Ive is structured so that there are top -level menu items each with one or more sub -menu

items .

Top-level menu items cannot be configured to link to individual pages, only sub  -menu items can link to
actual pages. Therefore you should think of the top  -level menu items more as groups of sub -menu links .

You can also add sub-menu groups , which contain sub -menu links. In fact, you can create multiple levels of

nested menus using this method.

What do you want to do?

Add a new top -level menu item

To add a new top -level menu item.
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1. In Evolve Designer's Layout pane, right-click the Menu node.
2. From the pop -up menu, choose Add Menu Link .

A new node titled ' Menu Link 'is created beneath the Menu node.

3. Select the new Menu Link node
4. Enter a title for the Menu Link using the Node Name field

This is the name of the top -level menu item as it appears in the web pages.

Set an icon for a menu item

To add icons to display next to menu items.

1. In Evolve Designer's Layout pane, click the Menu node to display the menu links wi thin it
2. Select the Menu Item you wish to set an icon for
3. Select the Icon Library , IconColor and Icon for the menu item.

4. Save your Site.

Custom Icons can ONLY be added to Index Pages and Object Pages , but not top level menu
items.

Add alink to an Evolve page

You can add menu links to Index Pages and Object Create pages which allow users to create
new objects.

You add a menu link to a page by creating a new sub -menu item for an existing top -level menu

ftem or sub -menu group ftem.

To add a menu link to an Evolve page

1. Right-click the menu node you want to add the menu link to.
2. Add your link:
0 Toaddalinkto an Index Page ,choose Add Index Page Link > Custom Pages > and
select the Index Page you want the sub -menu item to link to.
o Toaddali nktoa Create Object page to allow a user to create an Object in your
model, choose Add Create Object Page > Custom Pages > and select the Object Page
you want to link to.
A new sub-node is created representing the sub -menu item that wifl appear in that m enu
group.
3. Select the new sub -node.
4. Use the Node Name field to enter the name of the sub -menu item as it will appear in the web pages.

5. Save your Site.
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Add a sub -menu group node

Sub-menu group nodes are used to create multiple menu levels. You can add  one to a top -level
menu, or to any existing menu item. Like top -level menu items, sub -menu group nodes do not

link to a page, instead they are used to contain or group one or more sub  -menu links.

To add a sub -menu group node:

1. In Evolve Designer's Layout pane, expand the Menu node.
2. Right-click the menu item you want to add the sub -menu group to.
3. From the pop -up menu, choose Add Menu Link

A new node titled ' Menu Link 'is created beneath the selected node

4. Selectthe new Menu Link node.
5. Enter a title for the M enu Link using the Node Name field.

This Is the name of the menu item as it appears in the web pages.
You can now add sub -menu links to this new node.
Add a link to an Evolve Administration Page
You can add menu links to built -in pages to view administration data, such as Roles,
Questionnaires and so on, as well as to Object Create pages which allow users to create new
Objects.

You add a menu link to a page by creating a new sub -menu item for an existing top -level menu

ftem or sub -menu group item.

To add a menu link to an Evolve Administration Page:

1. Right-click the menu node you want to add the menu link to.
2. Add your link:
0 Toadd a link to an Administration Index Page , choose Add Index Page Link > Standard
Pages > and select the Adminis tration Page you want the sub -menu item to link to.
o Toadd a link to an Administration Create Object page to allow a user to create an
administration object, such as a Role or Question, choose Add Create Object Page >

Standard Pages > and select the page yo u want to link to.
A new sub-node is created representing the sub -menu item that will appear in that menu
group.

3. Select the new sub -node.
4. Use the Node Name field to enter the name of the sub -menu item as it will appear in the web pages.

5. Save your Site.
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Change the order of the top  -level menu

The order of the top -level menu can be changed by selecting and dragging the top -level menu nodes and
dropping them on main Menu node.

When you drag a node and drop it to the main  Menu node, that node is then pl aced at the bottom of the list.
To create the order you want, drag and drop the top -level menu nodes until the tree is ordered accordingly.
Change the order of sub -menu items

The order of the sub -menu items can be changed by selecting and dragging the sub -menu nodes and
dropping them on parent top -level menu node.

When you drag a sub -menu node and drop it to the top -level menu node, that node is then placed at the
bottom of the list.

To create the order you want, drag and drop the sub -menu nodes until the t ree is ordered accordingly.

Delete a top -level menu or sub -menu item

To delete a top -level menu or sub -menu item.:

1. In Evolve Designer's Layout pane, expand the Menu node.
2. Select the top -level menu node or sub -menu node you want to delete.
3. Right-click and choose Delete .

The item is deleted. If you deleted a top -level menu node, all its sub -menu items are also deleted.
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Publishing

Publish your Site

Evolve offers different options for publ ishing a Site. Use the table below to determine which option to use at

any given time.

You can also publish your site via batch command or scheduled task. To find out more about
batch publishing, see Command Line Publishing.

Menu: Home

Function Description
Dynamic Use when you publish your Dynamic Site for the first time, or when you want to do a full re -
Site publish - including all of the other options detailed below.

Use when you publish your Static Site for the first time, or when you wanttodo a fullre -

Static Site ) ) . . .
publish - including all of the other options detailed below.

Menu: Dynamic Deployment / Static Deployment

The following functions are duplicated on the = Dynamic Deployment and Static Deployment menus, as they
perform the same function and are different only in the respect of whether you are publishing a Dynamic or
Static Site.

Function Description

Use this option if you show Diagrams in your Site and have edited any of the Templates
they are based on.

Diagram Note: Only the Diagram Templates are updated during this operation - changes to Site
Templates pages are not published.

Note: Web Modeler Diagram Templates will be kept up to date automatically , there is
no need to use this option when you make changes to templates in  Evolve Suite .

Use this option if you have changed the Site's Theme or any of the icons used for the

Theme & Menu or Pages - this includes adding new Pages that have custom images.

Pictures Note: Only the theme and pictures are updated during this operation - changes to Site

pages are not published.
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Use this option to publish just the Site pages

without updating Diagram Templates,

Deploy Site .

Theme and Pictures.

Use this option to Save the Site, then publish just the Site pages without updating
Save & Deploy | Diagram Templates, Theme and Pictures.
Site It is likely you will use this option most of the time when creating and configuring

your Site.
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Command Line Publishing

You can if you wish publish your Site using a Command Line operation - which you could use to create a

scheduled task, or batch command.
You might want to do this if you have a Static Site and want to ensure your users are viewing the latest data
in your Model - so you could re-publish the Site daily or weekly.
To create a batch command for Command Line publishing.
1. In Evolve Designer, right -click the Model node for your Deployment and choose Add Batch Node .
A Batch Node is added below the Model node .
2. Select the Batch Node and configure the settings as follows:
i. Use Node Name to change the name of the Batch Node
ii. Use Connection to select the CW repository you want to publish from
By default the Connection you are using while logged in to Evolve Designer is selected
iii. Use CW User Name to enter the name of the CW User you want to generate your Site as

iv. Use CW User Password to enter the password for the above User, ensuring you click

the Encrypt button

3. Save the Site
4. Right-click the Batch Node and choose ' Copy baitch script into clipb oard

The command is copied to the clipboard for you to paste where you need it.

You can now open a Command Prompt and paste the command into it, paste it into a batch file, or

paste it into a Scheduled Task configuration.
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Use Tabs to Present your Data

Tabs are used as a way of grouping and controlling the way you present different information in your Index
Pages and Object Pages.

For example, on an Object Page , you might have a Tab showing the General properties of an object, then
use another Tab to sho w a list of Associated Objects , or Diagrams that the object appears on .

On an Index Page you might want to display some charts and a Table, offering different views of the same
information.

By using Tabs you can include much more information than the basic  object list or object details, but  all
content on the page must be displayed on a Tab

/'/7‘ \\\v,
[ U )| Please note that having multiple Tabs each referencing different Object Types could impact the

performance of your page, so we recommend being careful about not  overloading the page  with
content.

What do you want to do?

Add Tabs to an Object Page
/'/7‘ \\\-,
[ U )| These instructions assume you do not yet have any Tabs , but you do have a clean Object Page
b node, with an Object Type node already set to an Object Type, and a Layout setfo Object Page .
To add Tabs to an Object Page:
1. Under the Object Page node, right -click the Object Type node and choose New Tab Controller

A new Tab node is added to the tree .

2. Select the Tab node and use the Side drop-down to choose whether you want the tabs to be
displayed Horizontally or Vertically in your page.
3. Right-click the Tab node and choose New Tab

A new Tab titled 'Tab' is added to the tree
4. Select the 'Tabo' node and editthe Tab Name to what you want to be displayed in the web page
Repeat steps 3 to 4 to add multiple Tabs to your page

5. Save your Site.
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Add content to a Tab on an Object Page
Once you have one or more Tabs, you can choose what content to display in them. Within a Tab you can

display Property Groups , or Associated Objects displayed as a list, Table, or other layout option.

When you add new content, you use the Tab itself as the parent node

See Working with Property Groups to find out how to add Property Groups to a Tab.
See Working with Layouts and Behaviors to find out the different display opti  ons within Object Pages.

Add Tabs to an Index Page

You cannot add Tabs to an Index Page that already includes content - you must either Delete the

existing content first, or create a new Index Page

If you want to add Tabs to an Index Page, the Tab node must be the top -level node for that page in Evolve
Designer.
There are two ways to achieve this.

1. Create a new Index Page , butinstead of using the Add Index Page for Object Type option, use Add
Index Page

2. Use an existing Index Page, but Delete the Obj ect Type node and everything below it - do this by
right-clicking the Object Type node and choosing Delete. All previous content will be lost if you do
this.

The instructions below assume you have a clean Index Page node with no other nodes
beneath it.

To add Tabs to an Index Page:
1. Right click the Index Page node and choose New Tabs Controller .
A Tabs node is added below the Index Page node .

2. Select the Tabs node and use the Side drop-down to specify whether you want the Tabs to be
displayed Horizontally or Vertically on the page.

3. Right-click the Tabs node and choose New Tab.
A new Tab node is added .

4. Select the Tab node and use the Tab Name field to specify the name of the Tab as you would like it
too be displayed in the web page .
5. Right-click the Tab node and choose New Object List > [object -type]

An Object Type node and a Layout node are created .
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6. Save your Site.

You can now configure the content in the same way as you would for a normal Index Page without
Tabs.

Add contentto a Tab o n an Index Page
Once you have a Tab on an Index Page, you must create an Object Type node for the Tab - until you have an
Object Type node you cannot add any content.
To do this:

1. Right-click the Tab node and choose New Object List > [object -type]

An Object Type node and a Layout node are created.

Once you do have an Object Type node, you can add content just as you would for any Index Page.
See Working with Layouts and Behaviors for instructions on adding the different content types.

Add a new Tab to an existing Tabs Controller

To add a new Tab to an existing Tabs Controller:
1. Right-click on the Tabs node and choose New Tab
A new Tab is added to the bottom of the list of Tabs.
Change the order of Tabs in your page

You can change the order of Tabs in your page by dragging and dropping Tabs to the parent Tab node
When you do this, the Tab you moved is placed at the bottom of the list . By dragging and dropping Tabs in
the same order you want them to appear on the page, you can make the tree show them in the correct order.

Delete a Tab

To Delete a Tab:
1. Right-click the Tab you want to delete and choose Delete .
A confirmation dialog is displayed .
2. Click Yes.

The Tab is deleted.
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Use Custom Display Strings

On certain page layouts and behaviors you can now build a custom string to display the properties of your
objects or associated objects.

So, instead of just showing the Name of an objec t, you can build a string mixing one or more property values
of the object with some standard text.

For example, if you are I|isting Application objects, and t|
specify a custom string to display the Applica tion Name, followed by the Cost 2 s u ¢ h Agplgcation 1 -
$500

You can even show some meta data, such as the Object Type Name or Pluralname , or lookup
abbreviation .

And, if you have a Custom Site which is configured to support  Visual Indicators , you can display them
within a Custom Display String.

A simple syntax means it s easy to build the custom string:
values and all other text being di splayed as it is.

You can use custom property strings with the following layouts and behaviors:
0 Accordions 2 including when nested

0 Simple Lists

0 Tables 2 when listing Associated Objects in a column

0 List Boxes

0 External Picture layout

0 Visual Identity layout .

The page filter/search does not work with custom display strings and can only filter based on
Name.

URL property types are displayed as plain text with no hyperlink.

What do you want to do?

To create a Custom Display String

To create a custom display string:
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1. Select the Object Type or Association Type node you want to create the string for

2. Ensure all the properties you want to include in your string are selected in the Selected Properties
area

3. Select the Layout node for your page

4. Enter your custom string in the Custom Display String  field, for example ‘{name}: ({type})' to display
the object's Name, followed by a colon and its Category in brackets.

Use the following syntax rules:

Use curly brackets {} to surround Property Type scriptnames, for example {name}
Scriptnames must be entered in lower case

All other characters not included in curly brackets {} will be displayed as plain text
Use {cwobjecttype} to display the Object Type Name, for example, 'Process'

Use {cwobjecttypes} to display the Object Type Pluralname, for example, 'Processes’

O O O o o o

Use '_abbreviation ' after a lookup scriptname to display the Abbreviation for the drop down value, for
example {type_abbreviation}
o Use'_id' after a lookup scriptname to display the ID for the  drop down value, for example {type_id}.

If you leave the Custom Display String field blank, your layout or behavior will default to
displaying the Name.

If you enter incorrect syntax, it will be rendered as text in the web page.

5. Save your Site.
Use Visual Indicators inside a Custom Display String

If you have a Custom Site which is configured to support the use of Visual Indicators , you can display
them directly in a Custom Display String.

To do this, simply insert the reference in the custom string using the following syntax:

{<property-type scriptname>_image_mapping}

For example:
{type_image_mapping} or {validated_image_mapping}

Remember to ensure the properties you reference here are also selected in the  Selected

Properties area for the parent node.

The image will be displayed within the string alongside any other properties you reference.
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Static Pages in a Dynamic Site  pos.o2+

What does this mean?

A Dynamic Site offers a read, write access to your model, which means that content is generated as it is
requested by users. This generation, whilst highly efficient, can be slow when large volumes of data are
requested. Often pa ges which have large amounts of information, do not contain data which changes often.
Such pages could therefore be pre -generated, saving much server time, and make the user's experience
much more desirable.

The disadvantages to this method of generation a re that the content is not modified until the page is
regenerated. Also the page is not access controlled by Roles, so is available to all users.

None the less, this is often a tradeoff worth making for complex pages.

How to make a page Static?

1. Define a pa ge in your site as usual.
2. From the page settings, tick the checkbox, 'Display as Static Page'
3. You will be warned that new content will not appear in the site, until the static page is regenerated.

Layouts Options [cwWebDesignerTreeNodePage] - application
2-(C ) Object Pages ~
T : Page Name application
= 'JD application
B O Application Page Display Name Application
. ==
Layout Object Page
i o ey g g PageTitle
| B Tabs
! s Propert PageT
_ +- @ Properties age Type single
i +-- s Associations
i Add P. Filts
e Delivered QoS _mp e
i Warning X
i - @ Diagrams B
: - da Test . . . .
Enabling this option on an object page will prevent those
e "rl] attribute | objects from being editable. Adding a new object is possible
i but the static site needs to be generated again for it to be
+ —‘ﬂ businessrule visible on the site,
3 T cw_user_favorites
& AI datastore u
=
B rI: diagram T (-I_:| Application
- ]| document
==
2] entity Object Page Order lo
—
4 ]| eventresult
: _.I flow Display As Static Page

4 [l indicator

) T A

Fig. Set a page to contain static content

4. To generate (and regenerate) content for this page, right click on the page in tree
5. Choose the option 'Generate Content - Static Mode Only’
6. The page will be regenerated.
OR allow your end users to regenerate the page themselves with  'in-page refresh’.
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erwin Evolve 2 User Help Guide 74
Creating Sites and Pages



In-Page Static Content Refresh

Allow Users to Refresh Static Pages in a Dynamic Site [2018.1.0+]

What does this mean?

As the name suggests, a Static Page is generated at a point in time, and then made available. Its content
does not change. Why would you want a static page?

Sometimes a page is made static because itis a baseline, other times it is static to improve load
performance, as it changes less frequently.

If the page is static for performance, it might be nice to allow a user to ref  resh the page themselves. So
Evolve offers an In -Page refresh button.

Enabling In -page Refresh

1. First configure the page to be static
2. You will now be able to access the 'Allow refresh' options; "Disabled", "Everyone" or Roles. that exist
in your site.

B Evotvs Dengner (EA Foundasen - Sample Model » EASANP 14 - 01105 - O

Evoive bon Library

B Green

&) Appheatio

Obyect Page Order

Dapiey As State Page

Abow Refresh

Fig. Refresh static content settings
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3. Choosing "Disabled", which is default, will ensure that no  -one can refresh the page from the site.
Choosing "Everyone", will enable the refr esh button for all users of the site.
Choosing a specific Role, will enable the refresh button for users who are members of that Role.

Each static page has a "Last generated" time stamp, to indicate when it was last refreshed. A user can then
press the reg enerate button and have the server make the refresh.

Once refreshed, the page will reload with the updated content. This content will be available for all users
who subsequently visit the page.

b - Appacans Bacy O%io Aggt xalyon LSt Actiefly Manlie ng

Eaterprse Standad

Code ACT
Verdon
Criticaiey Low Crscaty

Contact M e - Sroman henngerrrepose com

Ga Live Dale

Fastat i ite v 41

Fig. Refresh static content, end user view

Help me choose a n option

0 When a page is a baseline, it may be most appropriate to disable the ability for end users to refresh
the content. This means the site administrator would be required  to use Evolve Designer to
regenerate the content when a new version is released. Often this is done with a batch run,
overnight, or on another trigger. However, it may be that the page could change throughout the day,
and you'd like an administrator to control when this happens. Going to Evolve Designer each time,
can be time consumin g, so choosing a Role that your Administrators are a member of, will ensure
only they can refresh the page from within the site.

0 Perhaps the page is owned by a particular department, and they like to make changes behind the
scenes, and then publish them. A gain using the Role restriction will ensure only the owners can
update the page.

0 In some environments the flexibility of allowing Everyone to refresh pages, is fine. If someone visits a
page, and would like to see the most up -to-date details, they can tap refresh and everyone will now
see the latest and greatest, when they visit.

Caveats

In 2018.1.0 this feature updates ALL object pages of the same type, and not just the page you are viewing.
While this could be useful, it was not intended. We planto  reduce the scope in subsequent releases, to just
the page you are viewing.
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Also, it is not possible to make a page both static AND editable. So the page would need to be duplicated in
Evolve Designer, with one page static, and one page dynamic. The dynamic page would be made available,
only to roles who are contributors. In this way a contributor would see the page twice. If they were to edit,

the editable version and save the changes, these changes would not be seen on the static page, until that
page was also refreshed.

This feature is in an early adopter stage, and we welcome comments and suggestions for improvement.
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Data Layout Options

Working with List (Simple)

The List (Simple) layout is the most basic display option for showing a list of objects.
It is the default Layout for all new Index Pages and displays objects in a simple bulleted list.

When used on an Object Page, a Simple List shows related objects , such as Associations or Diagrams the
object appears on .

What do you want to do?

Use the List (Simple) layout on an Index Page:
You can use a Simple List in more than one way on an Index Page.
To use as the main element of the page or Tab to list the objects returned:

Ensure the Layout node beneath the parent node is setto Layout List (Simple ). No other controls, layouts
or behaviors are required.

To use inside an Accordion to list Associated Objects:

Ensure the Layout node beneath the Association node is setto Layout List (Simple)

Read more about Working with Accordions.

Use the List (Simple) layout on an Object Page

The Simple List layout can only be used on an Object Page to show objects that are related to the object
which is in focus.

You must therefore have an Association node in your Object Page before you can use it.
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You can add an Association node at the top -level of the page - with an Object Page Layout , or inside a
Tab, where the top -level node in the Tab is an Association node.

To use a Simple List to display your Associated Obijects:
Ensure the Layout node immediately beneath the Association node is setto Layout List (Simple)

Display a title above your list

To display a title above your list, wherever y ou use it:

1. Select the Layout List (Simple) node you want to have a title
2. Enter the title you want to use in the Node Name field
3. Select the Display Title check box.
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Working with Accordions

This page describes how to create an Accordion within one of  your Evolve Site.

Accordions are used on Index Pages to display a list of objects, and then for each object a set of related
information, such as the object's properties, its associations, which diagrams it appears on, and so on.

Accordions are usually con figured to contain other layouts and behaviors inside them, which are exposed
when the user expands the node.

i
I
til i

You can also nest Accordions inside other Accordions, typically for listing Associated Objects.

What do you want to do?

Display a top -level Accordion in an Index Page

1 )
( || These instructions assume that you have already created a  basic Object List Index Page which

displays the list of objects you want to appea rin your Accordion.

To display a top -level Accordion in an Index Page:

1. Expand the node for the Index Page you want to add an Accordion to
2. Expand the Object Type node with the name of the Object Type, for example 'Process'

You should have a node representing the default layout ‘Layout List (Simple)'. If not, right  -click the
layout node and select Switch Layout > CW > List (Simple)

3. Right-click the node 'Layout List (Simple)' and select Add Behaviors > Navigation > Accordion
A new sub-node is create d under the layout node, titled 'Accordion’
4. Specify the settings for the Accordion

o0 Remove accordion header if empty  is only relevant if you are displaying another Accordion,
nested inside this one, so this setting can be ignored if you only have one  level.

If you do plan to have another Accordion nested inside this one, such as to list some

Associated Objects, you can switch off this check -box to specify that you want the top -level
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Accordion item to be omitted from the displayed list if it does not ha  ve any Associated

Objects.

0 Use Collapse by default to specify whether the Accordion is presented in a collapsed or

expanded state when viewed.
5. Save your Site.
The changes are saved.
Display data inside an Accordion

Once you have an Accordion, you need to s pecify what you want to be displayed inside it when a user

expands the node for each object.

You do this by adding one or more Property Groups to the parent node for the Accordion - this is usually
the Object Type node for a top -level Accordion, or the Association Type node if the Accordion is nested.

For a full explanation of using Property Groups, see: Working with Property Groups.

The instructions below detail how to add a generic Property Group.
1. Right-click the parent node for the Accordion and select New Property Group> Empty Group
The Property Group node is added.

2. In the Property Group's properties, choose the Layout you want and use the Selected
Properties area to choose which properties to display

3. Save your Site
The changes are saved.
Display an Accordion nested inside another Accordion

These instructions assume that you have already created an Object List Index Page which
includes a top -level Accordion displayin g a list of objects, and that these objects have Associated

Objects.

To display an Accordion nested inside another Accordion.

1. Expand the node for the Index Page you want to add a nested Accordion to
2. Expand the Object Type node with the name of the Object Type , for example 'Process'

You should have a node representing the default layout ' Layout List (Simple) ', under which you

should find the top -level Accordion.

3. Right-click the Object Type node and select New Association > [Object Type] > [Associatio n
Type] to create an Association node
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If you already have a node representing the Association Type you want to use with your nested

Accordion, skip this step

4. Expand the Association node

5. Right-click the Layout List (Simple) node and choose Add Behaviors > Navigation > Accordion
The new Accordion node is created .

. Specify the settings for the Accordion

o Ignore Remove accordion header if empty  as it cannot be used at this level.

0 Use Collapse by default to specify whether the accordion is presentedi n a collapsed or

expanded state when viewed.
. Save your Site.

The changes are saved.
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Working with Tables (Simple)

A Table (Simple) layout displays data in a simple tabular format . You can choose which columns you want
to be displayed, representing proper ties of the objects, or Associated Objects, and you can link to the Object
Page for the objects it shows.

Options Name Category Image
’; Automodeler Application productsfam.png
’; Casewise Modeler Application productsfcm.png
’; Gallery Application products/gallery.png
P; Matrix Application products/matrix.png
’; Model Explorer Application products/me.png
’; Object Explorer Application productsfoe.png
’; Simulator Application products/sim.png

However, unlike the Table (Complex) behavior, you cannot edit content in a Simple Table.
Why and how should you use one?

Use a Simple Table when you want to show more details for lists of objects than the other behaviors allow,
but you are not interested in sorting the columns or editing the displayed data.

Where and when can you use one?

Use the table below to see where you can use a Simple Table:

Page Type | Parent node Tabs Number on page Editable
) ) 1 - the Table must be the only element on
Index Page | Object Type node Yes - optional No
the page
Object Association Type Yes - 1 N
o
Page node mandatory

What do you want to do?

Insert a Table (Simple) into your Index or Object Page

7o insert a Simple Table into your page:

1. Select the parent node - Object Type node for Index Pages, Association Type node for Object Pages
2. Switch the Layout node beneath the parent node to Table (Simple)

To do this. Right-click the Layout node and choose Switch Layout > CW > Table (Simple)
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3. Right-click the parent node and choose to add a New Property Group > Empty Group or From
CM Panel.

This node is the parent node of the ‘Layout Table (Simple)’' node. For full details on Property Groups,
see Working with Property Groups.

4. Select the Property Group and use the Selected Properties area to choose all the properties you

want to be represented as columns in the Table

Add as many Property Groups as you want If you want complete control over the ordering of your

columns.
5. Save and Publish your Site.
Show Associated Objects in a Simp  le Table

You can configure your Table to include one or more columns displaying Associated Objects.

To add a column showing Associated Objects:

1. Right-click the parent node - Object Type node for Index Pages, Association Type node for Object
Pages - and select
New Association > [Object Type] > [Association Type] to create an Association node

A new node representing the Association Type Is created at the bottom of the list.
2. Save and Publish your Site.

The Associated Objects column is displayed as the last column in your table.
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Working with Tables (Complex)

A Table (Complex) behavior displays data in a gird format. It has columns that can be sorted or fil tered , and
optionally you can specify that users can edit the data presented in the Table, either inline , directly in the
cells, or by using a pop-up window.

You can use Tables on Index Pages and Object Pages to display properties of Objects and Associat ed
Objects, and on Object Pages only, you
can also show properties of Intersection Objects.

Editing content in a Table

A Table is the only display option that enables you to edit data in an Index Page

When you edit data in a Table you can edit the object's properties and associations (if you have associations
displayed).

You can choose whether to edit data inline or using a pop-up dialog. You must use a pop -up if you want to
edit associations.

You can also allow users to create new objects on a Table page, by using the Add Object setting.
Why and how should you use one?

Use a Table when you want to show more details for lists of objects than the other behaviors allow - and if
you want users to be able to edit the data.

Where and when can you use one?

Use the table below to see where you can use a Table:

Page Type | Parent node Tabs Number on page Editable
) ) 1 - the Table must be the only element on
Index Page | Object Type node Yes - optional Yes
the page
Object Association Type Yes -
1 Yes
Page node mandatory
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What do you want to do?

Insert a Table (Complex) into your Index or Object Page

To insert a Table into your page:

AN
; \

When you use a Table in an Index Page it must be used on its own - that is it cannot be
contained within an Accordion or other page display type.

1. Select the parent node - Object Type node for Index Pages, Association Type node for Object Pages
- and use the Filter Properties area to apply any filtering
2. Switch the Layout node beneath the parent node to Empty

To do this: Right -click the Layout node and choose Switch Layout > CW > Empty
3. Right-click the Layout node and choose Add Behaviours > Tables > Table (Complex)
A new node is added below the Layout node, titled 'Table (Complex)’
4. Select the new Table (Complex) node
The Table's settings are displayed
5. Edit the Table's settings:
0 Use Add Object to place an Add Object button on the page so users can create new objects

o Use Edit Mode to specify if you want the objects listed to be editable, and whether you
prefer inline editing in the Table or to use a pop -up window

Leave Edit Mode unset if you do not want to allow editing

7~ \\-,,

[ U )| /fyou show a multi -line text property, such as Description, in your table, and the content includes
HTML formatting, users will not be able  to edit the content via the table.

AN
Object Pages do not support pop -up editing , only inline editing is supported.

o Use Intersection Object Grid  if you want to be able to display the value of an Intersection

Object
See Display data from an Intersection Object in a Table (below) for further details.

6. Right-click the parent node and choose to add a New Property Group > Empty Group or From
CM Panel
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This node is the parent node of the 'Layout Empty' node referenced in step 3. For full details on
Property Groups, see Working with Property Groups.

7. Select the Property Group and use the Selected Properties area to choose all the properties you want

to be represented as columns in the Table
Leave the Layout setting as ‘table’.
8. Save your Site.
The changes are saved.
Include a Table column showing Associated Objects
You can configure your Table to include one or more columns displaying Associated Objects.
When you display Associated Obje cts in a Table, they can only be displayed as a simple List, showing just

the Name of the Associated Object.

Associations can only be edited in a Table if you set the Table to have an  Edit Mode of 'Pop-up".

To add a column showing Associated  Objects:

1. Right-click the parent node - Object Type node for Index Pages, Association Type node for Object

Pages - and select
New Association > [Object Type] > [Association Type] to create an Association node

A new node representing the Association Type is created at the bottom of the list. By default it is

given a List (Simple) layout - which is the only layout you can use.

2. If your Table is editable, or you plan to make it editable , you must choose which properties of the
Associated Obje cts to display on the pop -up edit dialog by adding a Property Group to the

Association node and selecting the properties to display, as nothing is displayed by default:

i Right-click on the Association node and choose New Property Group >Empty

Group or From CM Panel > [Pane Name]
ii. Use the Selected Properties area to choose which properties to display in the edit dialog
For full details on Property Groups, see Working with Property Groups.
3. Save your Site.
The changes are saved.
Display data from an Intersection Object in a Table
You can configure a Table, based on an Association Type, to display data from an Intersection Object.

A Table configured in this w ay will only show the Name of the Associated Object and then any properties of

the Intersection Object  you choose.
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You can only display Intersection Object data in a Table when the Table is used on an Object

Page.

7o do this:

1. Follow the instructions above to create a Table for your Index or Object Page, basing it on an

Association Type node
Your tree should look like this: Association Type node > Layout Empty > Table (Complex)

You do not need to add a Property Group to control which prope rties of the Associated Objects are

displayed, as Name is displayed by default.
2. Right-click the Association Type node and choose New Intersection Object
A new node is added for the Intersection Object, and it is given a List (Simple) layout by default

3. Right-click the Association Type node and choose New Property Group >Empty Group  or From

CM Panel > [Pane Name]
4. Use the Selected Properties area to choose which Property Types are shown in the Table

Each property you select is shown in a separate column in the  Table.

5. Save your Site.

Your Table is configured. When the page is viewed, you should see a Table showing the Name of
Associated Objects in the first column, followed by the
properties of the Intersection Objects in the following columns.
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Working with a Simple Matrix

The Simple Matrix requires that you have an Association Type defined between the two Object
Types you want to show.

A Simple Matrix can only be used on an Object Page, where one objectis therefore the focus.

It creates a table which shows Associated Objects for the object in question as column headings, and then
within the cells shows other objects that are also associated to those Associated Objects.

For example, if your Object Page was f ocused on a Process, you could use the Simple Matrix to show which
Risk objects your Process is associated to, and then beneath each Risk also show which other Processes
are also associated to those Risks.

When you use a Simple Matrix, the first level of Associated Objects are listed as columns in
the table - consequently the more you show, the wider the table will be.

We therefore recommend that you restrict the number of Associated Objects displayed n
the Matrix or it may become unusable.

To display a Simple Matrix in your Object Page:

These instructions assume that you are adding your Simple Matrix to a Tab on an existing Object

Page, and that the new Tab node already exists.
1. Right-click the Tab you want to add the Simple Matrix to, and ch oose New Association > [object -
type] > [association  -type]
This is to choose the Association Type you want to use to populate the column headings
An Association Type node /s added .
2. Expand the Association Type node and switch the Layout to Empty .
To do this: Right -click the Layout and choose Switch Layout > CW > Empty

3. Right-click the Layout Empty node and choose Add Behaviors > Matrix > Matrix (Simple)
4. Right-click the Association Type node created at step 1 and choose New Association > [object -

type] > [a ssociation -type]

This is to choose the Association Type you want to use to find out which other objects are associated

to each Associated Object returned by the parent node
An Association Type node /s added .

5. Save your Site.
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Please ensure you use unique Object Group IDs for the Association Type nodes.

If you have IDs which are the same as ones you have used elsewhere, you will see an error
reported when attempting to Deploy the Site.
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Working with an Advanced Matrix

To display an Advanced Matrix in an Index Page.

The Advanced Matrix is used to display associations between two Object Types, and can be
used on either an Index Page or an Object Page.

1. AnIndex Page can be added for an Object Type . In this example an Application has been added;

Layouts
=) 5? OnlineHelp
=3 f_t_j Index Pages
F | index_applications_technologies_matrix

=58 Layout Empty

. 5'.;' Matrix (Advanced)

- Application - Technology ()
=8 Layout Empty
& Reason for Involvement
58 Layout Empty
5] O Technology

58 Layout Empty

2. Avrelated Object Type can also be added to the same

been added,;
Layouts
=& ¥ OnlineHelp
— = @ Index Pages
=] index_applications_technologies_matrix
&) Application
558 Layout Empty
5-'-;' Matrix (Advanced)
o Application - Technology ()
8 Layout Empty
= ‘& Reason for Involvement
58 Layout Empty

=] O Technology

8 Layout Empty

Options [cwWebDesignerTreeNodeObjectNodeObjectType] - Application

Node Name |App|i(iti0n

Object Type Application

Object Group ID

|application_1;u3438uzg
SortOn '

Name
Sort Reverse
' Include Objects Only If .
Have Associations
Selected Properties CAverage Rating
[Ocategory

Index Page. In this example a Technology has

Options [cwWebDesignerTreeNodeObjectNodeObjectType] - Technology

MNode Name . Technology
ObjectType - Technology
ObjectGroupID | [tec hnology_37255636
SortOn . Name
Sort Reverse O

| Include Objects Only If
Hawve Associations

Selected Properties CAvailability End Date

~[JAvailability Start Date

3. The first object type should have its Layout switched to =~ Casewise > Empty, to allow a Matrix >

Matrix (Advanced)

to Casewise > Empty,

Behaviour to be added . The second object type should have its Layout switched

to prevent a list of these objects from being output.

The first object type will be the Row of the matrix, the second object type will be the Column.

4. The first object type should identify the relationship to be represented in the Matrix.

Association allows the relationship to the second object type to be selected.

the Application

A New

In this example

2 Technology () has been selected;
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5. The Association should identify its  Intersection Object Type . In this example itis a Reason for

Involvement ;
Layouts Options [cwWebDesignerTreeNodeObjectNodelntersectionObjectType] - Reason for
. Involvement
=-5% OnlineHelp
{:'" MNode Name |Reason for Involvement
=) @ Index Pages | |
| B~ [] index_applications_technologies_matrix Object Type e e e »

fl O Application
| =58 Layout Empty
!.';." Matrix (Advanced) ' SortOn I N -

(@ Application - Technology () l |
Sort Reverse

ObjectGroup ID |reason_for_invnlven'lent_1y,70969-93

58 Layout Empty O
- | Include Objects Only If | O
58 Layout Empty Have Associations
a O Technology Selected Properties Oallow Automatic Deletion L]
=8 Layout Empty [ Application id

6. The Matrix (Advanced) behavior can now have its Intersection Properties  added, and the Row

Object Group ID and Column Object Group ID  updated from the Application and Technology

object types;
Layouts Options [CwWebDesignerTreeNodeBehaviourMatrxTable] - Matrx (Advanced)
=& % Onli 'y
- \"3 C:nhMHe[p Node Name Matrix (Advanced)
&-(0) Index Pages . |
| =[] index_applications_technologies_matrix Matrix Type Matrix On Intersection v
&{) Application -
| O g Full Screen
&-58 Layout Empty O
By, . . . ) 1 |
Rl Mstrix (Advanced) Allow Edit of
I= é) Application - Technology () Intersection o
58 Layout Empty | Intersection r
p emove P
- s Reason for Involvement Properties MR Topertes
5 58 Layout Empty Property Disolay _Grow|
&) Technology ’
8 Layout Empty
[# | index_data_stores_list
| ®- || index_it_portfolios_list
=] G_) Object Pages Automatically v
& |'ﬁ] application _ Generate Custom _
&-{) Application Custom Display Sing | ey ncTIONSYNONYM]
£ Layout Object Page I T
S ow Object Group ID A
85 Genera! |applucat-cn_:;n3438¢zg
£8 Description Column ObjectGroup | [technology_37255636
= . D
55 Detals [ Intersection Node ID_|
w-[1]) datastore e €10 | |reason_for_involvement 1347096998

By default, the matrix cell will  contain the {name} of the Intersection instance as its  Display
String , until Intersection Properties  are added. In this example the Reason for Involvement
has had its Name property added, which Automatically Generates the Custom Display

String {FUNCTIONSYNONYM} .

The Intersection Node ID /s automatically updated when the Intersection Object Type is

established.
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The Published Example Advanced Matrix:

will take to refresh.

1 Objects with Associations Only

SRV_APP SRV_BDD Desktop #
_UKo2 _UKo3 | IT Archite ]

Application - Technology Matrixgl

Activity Monitoring

Application Portfolio Manage
r !

Business Object
Casewise Suite
Dashboard

ERwin Data Modeler

Finance Suite

Both Application and Technology object types have been restricted to  Include Objects Only If
they Have Associations . This will reduce the size of the matrix, and consequently the time it

SRV_APP SRV_WEB

_VM_USOj§ _Nvo1 i

SRV_BDD
_ukoz 8

It might also prove useful to Add a Page Filter to enable the size of the matrix to be reduced.

An active filter is likely to reduce the time to generate the matrix.
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9 AFiltered Page

« D OO®

SRV_APP SRV_BDD SRV_BDD SRV_APP SRV_BDD SRV_APP
_uko2 & _uko3z 8 _ukoz2 8 _uko1 8 _uxo1 8 _VM_UKOJ

Application - Technology Matrixdli

Activity Monitoring i

Application Portfolio Manage
r

Business Object

Casewise Suite

ERwin Data Modeler

Finance Suite

HR Access

Q The Row and Column objects could be filtered to reduce the number of rows or columns. For
example, the Applications could be filtered to only  include those with a Category = ERP;

9 Filtering Objects

& Om Filter Properties (AND) Property Operation Vaioe
B8 Layout Ei ~
=} r’u mpty |cmgory *'I- “lERP
&5 Matrix (Advanced) | v] vl

A matrix with too many rows and columns could take an unacceptable amount of time to generate.

Displaying Intersection Properties:

In the example output above, the Custom Display String  for each cell has been set to the Name of the
Intersection object. None of the Reason for Involvement associations have been given a name, as a
consequence the shaded cell contains no detail. The following example has the Number of Resources

displayed in each cell:
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9 Intersection Property

& || index_applications_technologies_matrix [ Intersection Properties
& o Application Add/Remove Properties
=58 Layout Empty Property Dusplay Value Group
BBy Vouix (Agvances| ’

I= (9 Application - Technology ()
8 Layout Empty
= & Reason for Involvement

EH Layout Empty | Automatically Generate Custorn |
2 O Technology Display String ©
£ Layout Empty Custom Display String {NUMBERINVOLVEDUSED]

9 Number of Resources

«~ B

- - SRV_APP_UK SRV_BDD_UK SRV_APP_UK SRV_BDD_UK SRV_APP_V
Application - Technology Matrixgll 02 B 03 3 01 3 01 3 M_UKo1 g

Business Object il
Casewise Suite 4
Finance Suite 1

HR Access 2 2

To display an Advanced Matrix in an Object Page:

The Advanced Matrix on an Object Page is similar to one created for an Index Page, but like the
Simple Matrix on an Object Page, the focus is on a single object.

1. An Object Page can be added for an Object Type . In this example a Process is to be added.

2. This object type should identify a relationship to the objects to be represented in the matrix rows. A
New Association is added under the object type. In this example a
Process - Application () is to be added.

3. The related object type should have its Layout switched to =~ Casewise > Empty , to allow a Matrix >
Matrix ( Advanced) Behaviour to be added.

4. The first related object type should now identify th e relationship to be represented in the
Matrix. A New Association allows the relationship to a second related object type to be
selected. In this example the Application 2 Technology () is to be selected.

5. The Association should identify its Intersection Object Type . In this example itisto be a Reason
for Involvement.

6. The Matrix (Advanced) behavior can then have its Intersection Properties added, and the Row
Object Group ID and Column Object Group ID  updated from the Process 2 Application ()
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and Applicat ion - Technology () nodes;

sMatrixTable] - Matrix (Advanced)

Layouts Options [CwWebDesignerT:
=] @ OnlineHelp £ Node Name
=] @ Index Pages
@ || index_applications Matrix Type
@ || index_applications_technologies_matrix
& [ index_processes Full Screen
& [ index_technologies [ Allow Edit of Intersection |
&-(C) Object Pages
= _j] application Intersection Properties.
=] __T] process
5] O Process
58 Layout Object Page
ﬁ Property Group
= 'T,] process_matrix
=] O Process
'ﬂ. Layout Object Page Automatically Generate

Custom Display String
Custom Display String

=] é.) Process - Application ()
=58 Layout Empty
s
= é) Application - Technalogy ()
58 Layout List (Simple)
& Reason for Involvement

8 Layout List (Simple)

Row Object Group ID

[ Column Object Group ID

=]
Intersection Node ID

Matrix (Advanced)

MatrixOn Intersection -
.D
m}
- Add/Remove Properties
Property DisplayValve  Grouo

[FUNCTIONSYNONYM]

|appllcatnn_wg:g_l:3360nu

|te:hnology_;|.og:9_1 361533860

[ruson_for_invo!umm_;: 28200622

The need to reduce the size of the Object Page matrix is less likely, as only the objects related

to the selected object, and their related objects will be included in the matrix.

The Published Example Advanced  Matrix:

9 An Application to Technology matrix for a selected Process;

Desktop #
IT Archite Jjj

SRV_BDD_ SRV_WEB

- il
Application - Technology Matrixgl UKO3

Business Object

Casewise Suite

ComptaPlus

Dashboard

Editing Intersection Properties:

In the example output above, the Custom Display String
Intersection object. None of the Reason for

_NYO01

SRV_APP_
FR_Prod

SRV_APP_

SRV_BDD_
' vMm_ukoid]

uso0l

for each cell has been set to the Name of the
Involvement associations have been given a name, as a

consequence the shaded cell contains no detail. It is possible to Edit the Intersection Properties, by clicking

on the Edit button above the matrix;

i Editing the Name of an Intersection
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Application - Technology Matrix SRV_BDD_UK03 Desktop # IT Architect

storedin| X @ 2]
8

Business Object

This is opticnal and for de
Casewise Suite Oo

o)
ComptaPlus % S
Dashboard % S
< I >

It is possib le to create new relationships by clicking on the  1ink'icon, or to delete existing
relationships by clicking on the bin ' icon.
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Working with Tabs based on Lookup
Values

Tabs based on Lookup Values is a list -based display that organizes your objects into groups based on the
value of 'Lookup' (drop -down) properties such as Category .

Vertical tabs on the left side of the page are used to represent the values, while the objects themselves in
each tab are displayed in simple lists.

Obijects listed using this display type cannot be edited directly.

You can optionally include an Overview Chart which creates an 'Overview' tab displaying a Pie Chart
showing the proportion of each value. The Overview Chart is identical to the chart display =~ ed when using
the Pie Chart based on Lookup Value  behavior.

The Tabs based on Lookup Values display requires that you have drop -down properties in your
model. It will work with the default drop -down Category , as well as any user-defined drop-
down properties in your model.

To create an Index Page using Tabs based on Lookup Values:

1. Create a New Index Page with a List (Simple) layout
2. On the Object Type node, ensure you select 'Category' in the  Selected Properties area
3. Right-click the Layout List (Simple) node and choose Add Behaviors > Navigation > Tabs on

Lookup Values
A Tabs on Lookup Values node is added below the Layout node.

4. Select the Tabs on Lookup Values node and enter the Scriptname of the drop -down property you
want to refer to in the Filter Lookup field

You can find the Scriptname in Model Explorer's Design View.  The scriptname for the default
Category drop -downs on objects is always 'TYPE"

5. Use the following optional settings:

o0 Use Overview Chart to specify that you want the first tab to be an Overview tab showing a
Pie Chart summarizing the distribution of the values
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0 Use Not Display Undefined to specify that the page should not include or display any
objects that has a value of 'Undefined'.

6. Save your Site.

Remember to add a Menu item for your new page.
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Filtering Data

Page Queries and Filters

This page explains how to use page queries and filters so that your pages only display objects that match
certain conditions that you specify.

By default Ind ex Pages, and Association Type nodes on Object Pages |, list all the instances of the Object
Type you specified - for example all Processes in your model.

However, you can create association queries and conditional filters which result in only a restricted | ist. For
example, you might want an Index Page which shows a list of Processes, but you only want to see Processes
of a certain Category, or that are associated to another object.

These queries and conditional filters can be applied to most Index Pages, as  well as most Object Pages
which use Association Type nodes to display Associated Objects.

There are two types of conditional filters that can be applied to the results to form a query:

1. Filters based on object properties
2. Filters based on associations.

Filter Operators

Text-string filters and select -list filters can be combined in a formula using filter operators. This allows for
greater versatility when filtering objects.

The filter operators and their functions are listed below:

Operator Function Description

= equals Matches to any values that are equal to the inputted value.

I= does not equal Matches to any values that are not equal to the inputted value.

> is greater than Matches to any values that are greater than the inputted value.
< is less than Matches to any values that are less than the inputted value.

is greater than or _
>= . Matches to any values that are equal to or greater than the inputted value.
equal to

is less than or equal )
<= ) Matches to any values that are equal to or less than the inputted value.
(0
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N is withi Matches to any values that are one of the inputted list of values. Operates
is within
with List, Text and Numeric values.

Filter based on object properties

Filters based on object properties can be applie dto any Layout or Behaviour on any Index

Page or Association Type node on an Object Page
These filters restrict the results based on one or more  properties of the objects to be displayed.

You can add multiple property filters, which combine to form a single query where each condition must be

met for the object to be included in the results, so for example:

Display all Processes where.
Category = X'
AND Validated = 'TRUE’

While individual conditions are joined with the  AND operator in your complete filter query, when you add a
condition referencing a Drop -down , ID or Single Line Text property, you can specify multiple values which
are treated as OR within that particular condition. So, for example, you could create a filter query like:

Display all Processes where
Category = X'OR 'Y'OR Z'
AND Validated = 'TRUE'

IMPORTANT : You can only use OR conditions with the following standard property
types: Name, Category , UUID, ID. User-defined property types are not supported :

In addition, you can only use one OR condiition in a filter set.

NOTE: The OR operator is shown as 'IN' in the Evolve Designer interface.

Add a property -based filter
Filters based on association

IMPORTANT : You can only use a filter based on association when  you are not already using an

Association Type node for any other purpose in your Index or Object Page.

In addition to property based filters, you can restrict the  list of objects displayed on a page by way of
association. This could be by association to any object of a specified type, orto a specific object or objects

of a specified type.

For example, you could create a filter like:
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Display all Processes where Category = X'

AND Process Is Associated To any Location.

You could extend the filter to reference a specific associated object, such as:

Display all Processes where Category = 'Y’

AND Process Is Associated To Location Z'.

You can even extend these basic examples to add multiple nested association conditions to filter the
results by way of indirect association . For example:

Display all Processes where Process Is Associated To any Location

AND where Location Is Associated To Organization ‘UK.

Finally, you can of course add property - based filters to any association filter, enabling youto create

sophisticated page queries such as:

Display all Applications where Date for Review > 'date’
AND Application Is Associated To an Organization
where Organization Categ ory ='X' OR "Y'

AND Organization Is Associated To the Location 'US'

When filtering results by association on an Object Page, remember that the parent node will
always be an Association, so the list you are filtering is a list of associated objects.

On an Object Page it is not possible to present a list of objects indirectly associated to the object
that is the subject of the page. It is only possible to list objects that are indirectly associated to
objects that are associated to the subject.

Add a filt er based on association

Filters Properties

The following properties can be used to configure a filter:

Name Notes

Average Rating

Category

Created By Format: DD/MM/YYYY HH:MM:SS  E.g.: 22/12/2015 14:34:42

Creation Date Format: DD/MM/YYYYHH:MM:SS  E.g.: 22/12/2015 14:34:42
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Date Validated

Display Name

Freeze Level

Id

Name

Owner

Template

Total Comment

Unique Identifier

Updated By

Updated Date

Format: DD/YY/MMMM HH:MM:SS

E.g. 22/12/2015 14:34:42

Validated
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Property Groups

Working with Property Groups

Property Groups are page elements that display the properties of the object in question. They are used
on Index Pages , such as within an Accordion , or Table , or in Object Pages .

There are two ways you can enter Property Groups into your pa  ges:

1. By using the Empty Group option
2. By using the From CM Panel option.

The Empty Group option creates one group within the page and then you can choose which of the object's
properties to display within it - nothing is selected for you by default

The From CM Panel option allows you to choose a group based on one of the Panes in the object's
properties, such as General , and automatically selects all the properties within that Pane to be displayed in

the group.
/‘/// \\\
(?) When inserting a Property Group, we recommend you only display a small number of properties in
h any particular group -

your page will look much better if you restrict the number of properties in each one.

Property Group Layouts

When you insert a Property Group there isa Layout setting which determines how the content within the
group is displayed.

Certain layouts only work with certain types of properties. Please use the Property Group Layout Table to

see which layou t to use when.
Property Groups and Tables

The Property Group feature is also used when configuring a Table to specify which properties you want to
be displayed as columns in the Table. The details for using Property Groups in this way are included in the

instructions for creating a Table. See Working with Tables  for further information.

What do you want to do?

Insert a Property Group on an Object Page
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Ifyou use Tabs on your Object Page you can only insert a Property Group beneath a Tab node.

If you do not use Tabs, you can insert the Property Group beneath the main Object Type node.

To in sert a Property Group on an Object Page.

1. Expand the node for the Object Page you want to add the Property Group to

2. Right-click the node (Tab or Object Type) you want to add the Property Group to and choose
New Property Group > Empty Group , or New Property Group > From CM Panel > [Group
Name]

See the beginning of this page for explanations of each option
3. Configure the Property Group settings:

0 Use Property Group Name to specify the name of the group as it is displayed in the web
page.

o The Identifier setting holds a unique identifier for the Property Group. You should have no
reason to change this setting.

0 Use Layout to specify which layout to apply to your Property Group.

See Property Group Layouts  for explanations of each layout type.

o0 Use Selected Properties to specify all the properties that will be displayed in the Property
Group.

Remember, we recommend only using a small number of properties in any one group.

4. Save your Site.
The Index Page's properties are saved.

Insert a Property Group inside an Index Page Accordion

To insert a Property Group inside an Index Page Accordion

1. Expand the node for the Index Page you want to add the Property Group to

2. Right-click the node that is two steps above the Accordion you want the Property Group to be
displayed in and choose
New Property Group > Empty Group , or New Property Group > From CM Panel > [Group
Name]

See the beginning of this page for explanations of each option

3. Configure the Property Group settings:
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0 Use Property Group Name to specify the name of the group as it is displayed in the web
page.

o The Identifier setting holds a unique identifier for the Property Group. You should have no
reason to change this setting.

0 Use Layout to specify which layout to apply to your Property Group.

See Property Group Layouts  for explanations of each layout type.

o0 Use Selected Properties to specify all the properties that will be displayed in the Property
Group.

Remember, we recommend only using a small number of properties in any one group.

4. Save your Site.

The Index Page's properties are saved.
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Property Group Layouts

When you use Property Groups to display object properties within your Site Pages, you must choose

a Layout to apply to the group.

The layout controls how the properties are displayed, but some layouts are only to be used with certain

types of property.

The table below details each layout and in which case it should be used:

Layout Description Used for

This is the default layout which can be used with any type of Any type of property,

table property. Properties are displayed in a tabbed format with except multi -line text
property name > property value. fields.
The FlatList layout is especially useful on Diagram Popouts Any type of property -
FlatList as it can be used to combine multiple properties , including | especially on Diagram
multi -line texts, in one simple 'flat’ layout. Popouts

This layout is especially for multi -line text properties , such

as 'Description'. It is better at presenting potentially longer

. Multi -line text fields
memotext pieces of text than the standard table.

with plain text content.
The use of Enhanced Multi -line Text Control will enable the

use of rich text formatting for HTML content.

This layout is has been deprecated in version 3.0 and
htmlbox ) n/a
replaced with the Memotext Layout (above).

This layout allows users to proceed withou t selecting any
helptext properties. The Property Group Name can then be used to Displaying help text
display help text

) . Number fields where the
The gauge layout displays a visual gauge on a scale of 0 to .
) ) value is between 0 and
100. The pointer represents the value of the property. This ) )
gauge . ) . . 100. Text fields which
type of layout is especially useful for displaying percentages ) )
] ] include just a number
in a visual way. )
will also work.

The embedURL layout creates a frame within your page that

isplay th f RL - |
embedURL can open and display the target of a U property - as long URL property types only.

as it is properly formatted and starts with ‘http://".

Therefore, if you have a URL property which contains a link
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to your corporate website, you can display the web site
within the frame in your object page.

If you want to use this layout in your Property Group, you can
only use the group to reference one property.

Note: In order for URLSs to work in this way, the URL
property on your object must be on its own Pane. See the
CW Suite help for positioning Propert y Types on Panes.

Note 2: You cannot edit the URL Property using the
embedURL layout. To make a URL property editable in
Evolve you must expose the property on another part of the
Object Page.

[Note 3:] If you reference a PDF document, ensure that if

your users are accessing your Site using Internet
Explorer that they have a PDF reader plugin installed.

The image layout is used to display properties that are image

Image property types

the same central point.

image files, and result in the image being displayed in the web only.

page. Images are not commonly used as properties.

The imageFromURL layout is used to display an image for an

object which uses a Single -Line Text or URL Property Type URL or Single-Line Text
) to store an HTTP reference to an image file. properties used to store
imageFromURL

If you want to use the imageFromURL layout in your HTTP references to an

Property Group, you can only use it to reference one image file.

property.

The radar layout is used to create a chart that displays three
radar or more Object properties on different axes which start from Number fields

Property Group Name

The property group name is displayed in the title bar of the property group. In the case of options such
as 'embeddedUR L' or 'imagefromURL" the default title is the full URL.

Since Evolve 2016.1.1 the ability to use a 'Custom Display String'

or property variables in this display.

For example: The default use of an embeddedURL may look like this:

means it is now possible to use any text,
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Process Claim Jenny Hylton

e fr fe fr e 00000
P G

Name Process Claim

Details

Responsibilities (RACI) com/evolve/v2016-1/docs/Evolve-Release-Notes.pdf
Casewise Evolve Release Notes
Process Flow
Published

Drafts

WHAT'S NEW IN EVOLVE 2016.1.1

However the URL is seldom a useful attribute. So using the  'Custom Display String'  to display some simple
text, and optionally a variable (e.g. Name), it is possible to adjust the configuration like this:

Home | Dynamic Deployment  Static Deployment

W dd ® & O

Save Dynamic Site  Static Site Update Meta Model  Show/Hide Object Types Online Help
Design Publish Administration Help
Layouts Options [cwWebDesignerTreeNodePropertiesGroup] - Documentation
B ~
i j] jatsbase Riopsry Group Name |Documentat|on | it
(3] :ﬁ] diagram
o :ﬁ] entity \denfier |propertyGroup_117971774 |
@ @ eventresult
= Custom Display Strin i [ "
& j] organization play 9 |Document|mkfor {Name}’ |
Eagoot lembedURL 5
Selected Properties M General
j [IName
= i
- Details ; g:ltternate Name
== b ategory
i EE e [implementation
= e i
55 Description ~MDocumentation
EE “-[IDecomposition Number
@ é) Business Area [ODescription
- Responsibilities (RACI) g?"iﬁ‘;“’i,
pecification
v @@ Data Management [JFrequency/Growth
) Template Nodes [JCosts
Throughput

erwin Evolve 2 User Help Guide 109
Property Grou ps



Data Visualizations

Visualizing Data in  Evolve

There are a number of ways you can use Evolve to visualize the data in your model.

1 Use Diagram Des igner visualizations

1 Use dedicated behaviors like Pie Charts, Bubble Charts, Bar Charts, Roadmaps, Cost -Benefit
Charts and Vector Maps

1 Use Visual Indicators

These features each offer different ways of allowing you to present your data in a visual way, from giving
high-level dashboard views, to exposing the details behind individual objects.
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Working with Pie Charts based on

Lookup Values

Pie Chart based on Lookup Values gives you a percentage view of the number of objects of a specified

Object Type that are set to the different values for a specified Lookup (drop ~ -down) property, such

as Category .

It creates the same pie chart as the one displayed on the optional Overview Chart created by the Tabs

based on Lookup Values behavior.

To create an Index Page using Pie Chart ba  sed on Lookup Values:

A W N

. Create a new Index Page

. Right-click the Layout node and choose Switch Layout > CW > Empty

. On the Object Type node, ensure you select 'Category' in the  Selected Properties area

. Right-click the Layout Empty node and choose Add Behaviors > Pie Cha rts > Pie Chart (On

Lookup Value)

A Pie Chart (On Lookup Value)  node is added below the Layout node.

. Select the Pie Chart (On Lookup Values) node and enter the Scripthame of the drop -down property

you want to refer to in the Group By field

You can find the Scriptname in Model Explorer's Design View. The Scriptname for the default
Category drop -downs on objects is always ‘type'. Scriptnames must always be entered in lower case.

. Save your Site.

Remember to add a Menu it em for your new page.
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Working with Recursive Pie Charts

Unlike the standard Pie Chart based on Lookup Value  which shows you the break -up of objects based on a
drop-down property, the Recursive Pie Chart allows you to show a top -level chart which sums the values
of properties of Associated Objects (or Intersection Objects), and then allows usersto  click those items to
view a second chart showing all the objects associated to the selected object.

You can include multiple levels of associations in one chart, so users can drill down from one to another.

Step 1 Step 2 Step 3

| A

The Recursive Pie Chart requires at least one Association Type  to work, as well as a Whole
Number or Decimal Number property on the Associated Object - or Intersection Object.

Why and how should you use one?

You should use a Recursive Pie Chart when you wantto get an overview of some underlying data by way
of an Association. Think of it as a visual representation of the sum of a numeric property on associated
objects.

For example, you have some Technology objects, each with a Cost property, and in your
model, Technologies are associated to Organization objects which are used to represent Departments in
your business.

In this example you could use the Recursive Pie Chart to show Technology Cost per Department . The chart
is configured to show Organization objects - but the size of each piece is based on the total

(summed) Cost of the Technology objects associated to each one.

While the above example examines one level of association, you can extend this basic functionality to
include more steps, by adding additional Association Types, allowing you to visualize the data of objects
Indirectly Associated to the higher -level objects. The result is to have more click -through pie charts, one
focusing on a different Object Type in the chain.

For example, if your Org anization owns a number of different companies, your data could consist of:

1 Company objects used to define companies in the group
1 Country objects used to define countries where you have offices
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1 Department objects used to define departments within the  company
9 Technology objects used to define server machines.

The Technology objects have a Cost property to specify the running costs per year for each machine.

Your model has Association Types linking these Object Types together - in the following path. Company >

Country > Department > Technology

You could then use a Recursive Pie Chart to show the summed costs of server machines (Technologies)
per Company , then after clicking through by Country, and then by  Department, in one interactive chart.

See Use multiple Association Types to visualize Indirect Associations  below for details.

You can sum properties of the Intersection Object instead of the Associated Object if you
wish.

Where and when can you use one?

Use the table below to see where you can use a Recursive Pie Chart:

Page Type Parent node Tabs Number on page | Editable
Index Page | Object Type node Yes - optional 1 or more No
Object Page | Association Type node | Yes - mandatory | 1 or more No

What would you like to do?

Add a Recursive Pie Chartto  your page

These instructions lead you to create a basic Recursive Pie Chart , which results in a pie chart
showing instances of the first object, sized by the sum of a property of the associated objects,
then a second pie chart users can drill down to  which shows instances of the associated

objects for just one of the top -level objects.

By following these instructions you could create the Organization to Technology (Cost) example

described above.

The parent node mentioned in the instructions is the  Obje ct Type node for an Index Page -

optionally within a Tab - or is the Association Type node within a Tab on an Object Page.

1. Select the parent node - Object Type node for Index Pages, Association Type node for Object Pages
- and use the Filter Properties area to apply any filtering

2. Switch the Layout node beneath the parent node to Empty

To do this: Right -click the Layout node and choose Switch Layout > CW > Empty
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3. Add the Recursive Pie Chart behavior to the Layout node

To do this. Right -click the Layout node and choose Add Behaviors > Pie Charts > Pie Chart
(Recursive)

A Ple Chart (Recursive) node is added

4. Add an Association to the parent node - choosing the Associated Object Type which has the property
you want to sum

To do this. Right -click t he parent node and choose New Association > [object  -type] >
Jassociation -type]

A new Association Type node is added

5. Select the Association Type node and inthe Selected Properties area, tick the property you want to
sum on the chart
6. Select the Pie Chart (Recursive) node and configure the following settings:

o0 Use the Node Name to set the name of the node as it appears in the tree - you only need to
edit this if you are using multiple Recursive Pie Charts

0 Use Leaf Object Type Scriptname  to specify the Scripthname of the Associated Object Type
- for example, 'technology’

0 Always use lower case when referring to Scriptnames

o Use Property Scriptname to Sum  to enter the Scripthame of the property on the Associated
Object you want to sum

0 Use the Where is the Pr operty to sum drop-down to choose whether you want to sum a

property of the Associated Object, or a property of the Intersection Object

See the separate instructions below for more details on using the Intersection Objec  t

o0 Use Property Unit to specify t he text to be displayed on the chart for the sum value

0 Use Intersection Object Type Scriptname to specify the Scriptname of the Associated
Object Type

Use the same Scriptname as for the Leaf Object Type Scriptname
7. Save your Site.
Use a property of the Intersection Object for the sum

You can configure your Recursive Pie Chartto sum the values of Intersection Objects rather than values of
the Associated Objects themselves.
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Just as with values for Associated Objects, the properties must be ~ Whole Number or Decimal
Number .

The instructions for creating a Recursive Pie Chart in this way is exactly the same as for
referencing an Associated Object, with the following exceptions:
1. Set the Where is the Property to sum  drop-down to 'On the intersection be fore'
2. Use Property Scriptname to Sum  to enter the Scriptname of the property on the Intersection Object
you want to sum

3. Use Intersection Object Type Scripthame to specify the Scriptname of the Intersection Object Type.

Use multiple Association Types to visualize Indirect Associations

If you want to add more steps in your Recursive Pie Chart using multiple levels of

associations, you should follow the points below:

1 Nest additional Association Type nodes beneath each other - add the next Association Type b y right-

clicking on the Association Type node you want to nest beneath
1 On the Recursive Pie Chart node the settings should reference the object at the end of the chain -in

the example case, the Technology.

erwin Evolve 2 User Help Guide |
Data Visualizations |



Working with Roadmap Gantt  Charts

Roadmaps require two Date/Time properties  on your object to store the Start and End date of
each item you want to display.

A Roadmap is a type of Gantt Chart that enables you to  show a number of objects  and their start and end
dates .

For example , you could have a Project object, which has Start Date and End Date properties. On your
Roadmap you could show all the Projects associated to a specific Department and what their start dates
and end dates are, viewing any overlaps or gaps.

You can optionally display Categor ies like a menu in the web page which allows users to filter the list
dynamically when viewing the page.

You can use Roadmaps as the main element on Index Pages , or beneath an Association Type node on
Object Pages .

What do you want to do?

Create a new Roadmap Gantt Chart for your page

7

These instructions assume that you have already created your page , including
any filtering you may want so that only the objects you want displayed are shown.

To create a new Roadmap Gantt Chart for your page:
1. Ensure the Layout node for your element is setto Empty
For an Index Page the Layout node is the one directly under the Object Type  node.
For an Object Page the Layout node is the one directly under the Association Type node
2. Right-click the Layout node and choose Add Behaviors > Gantt Charts > Gantt Chart (Roadmap)
A Gantt Chart (Roadmap) node is added below the Layout node

3. Select the Gantt Chart (Roadmap) node and set the properties
/‘/// 7\\\
Use lower case fo enter Scriptnames.

i Use the Start Date field to enter the Scriptname of the property used to store the start date

ii. Use the End Date field to enter the Scriptname of the property used to store the end date
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iii. Use the Filter Lookup Property  field to enter the Scriptname of a drop -down property that
you want d isplayed like a menu in the web page so that users can click to filter the displayed
list of objects in the Roadmap

4. Select the Object Type node and use the Selected Properties area to select all the properties you
referenced at step 3 - that is the Start D ate and End Date properties, as well as the Category .
5. Save your Site.

The Site is saved and the Roadmap Gantt Chart is created.
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Working with Lifecycle Roadmaps

A Lifecycle Roadmap is a type of Gantt chart that enables youto  show a number of objects , displaying their
overall time frame, as well as highlighting in different colors  the phases involved in their lifecycle

You can display any nhumber of phases in your lifecycle.

When you use a Lifecycle Roadmap you can also show the names of each of the phas es in a color-coded
legend so users can understand the chart.

You can use Lifecycle Roadmaps as the main element on Index Pages  only.

Lifecycle Roadmaps require that you have a total of ~ Date/Time properties  on your object to
represent the Start dates of each phase in the cycle,

and an additional Data/Time property is required to store the End date of the final phase.
Why and how should you use one?

Use a Lifecycle Roadmap when you want to view the lifespan of an object, suchasa  Project, but you also
want to see the breakdown of phases within the overall timeframe.

For example , you could have a Technology object representing a server, which has four lifecycle
phases: Development , Testing , Active , and Retirement . Each stage has a
corresponding Date/Time property to represent the start date of the phase, and the final phase also has a

corresponding end date property.
Where and when can you use one?

Use the table below to see where you can use a Recursive Pie Chart:

Page Type Parent n ode Tabs Number on page | Editable
Index Page | Object Type node Yes - optional 1 No
Object Page | Association Type node | Yes - mandatory |1 No
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What do you want to do?

Create a new Lifecycle Roadmap for your page

N
| U )| These instructions assume that you have already created your page , including

any filtering you may want so that only the objects you want displayed are shown.

To create a new Lifecycle Roadmap for your page:

1. Use the Selected Properties area on your Object Type node to select all the properties  you want to
reference on the roadmap
2. Ensure the Layout node for your elementis setto Empty

For an Index Page the Layout node is the one directly under the Object Type  node.

For an Object Page the Layout node is the one directly under the Association Type node
3. Right-click the Layout node and choose Add Behaviors > Roadmap Lifecycle

A Roadmap Lifecycle node is added below the Layout node

4. Select the Roadmap Lifecycle node and set the properties

RN
[ U )| Use lower case to enter Scriptnames.
NG/

i. Use the Dates field to enter a comma -separated list representing the start dates of all the
phases in your roadmap, as well as the end date of the final phase

Enter the Scriptnames of the start date properties  for each of the phases in the lifecycle,
followed by the Sc riptname of the end date property of the final phase

For example: astart,bstart,cstart,dstart,dend

ii. In the Steps field enter the names of each of the four phases as you want them to be
displayed in the web page, separating them with a comma

Example: 'Develo pment, Testing,Active, Retirement '
5. Save your Site.

The Site is saved and the Lifecycle Roadmap is created.
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Working with Cost/Benefit Charts

A Cost/Benefit Chart enables allows you to compare properties you class as Costs in your organization

against properties you class as Benefits .

(e -

rrii.tgll'[

*h

The result is a type of color -coded bar chart which highlights the costs and benefits, as well as

a calculated cost/benefit value
There is no limit to the number of cost and benefit properties you use, but  obviously the more you do use,

the more unusable the chart will become.

Cost/Benefit Charts require that you have  Whole Number or Decimal Number properties for
your Costs, and either Whole Number , Decimal Number of Drop -down properties for your

benefits .

Ifyou do use Drop -down properties for benefits, these should include a number, such as:
1- Low
2 - Medium
3 - High

You can have multiple costs and multiple benefits on one chart.

Why and how should you use one?

An example of using a Cost/Benefit Chart might be to show the  business benefit of expenditure on

software applications

A number property could be used to store the actual monetary cost of the application in your organization,

while a drop -down could be used to assign the impor tance of the application to the business - from 1 to 10.

Using the chart, you would then be able to get an overview as to whether you were spending a lot of money

on applications that have little business value.
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Where and when can you use one?

Use the table below to see where you can use a Cost/Benefit Chart:

Page .
Parent node Tabs Number on page Editable

Type

1
Index Object Type Yes -

. The Chart must be the top -most item on the No

Page node optional

page

What do you want to do?

Create a new Cost/Benefit Chart

To create a new Cost/Benefit Chart for your page:

1. Ensure the Layout node for your element is setto Empty
2. Right-click the Layout node and choose Add Behaviors > Other Charts > Cost - Benefit Chart

A Cost-Benefit Chart node is added below the Layout node.
3. Select the Cost-Benefit Chart node and set the properties .
i. In the Costs area, select the properties you want to use as costs on the chart.
ii. In the Benefits area, select the properties you want to use as benefits on the chart.
iii. Use the Multiplier field to enter the multiplier number for equalizing calculations.
' || Costs tend to have higher values than those you assign to determine benefits such as business

importance. For example a cost might be 10,000, but the business importance mig  htbe 3 -
High.

The Multiplier can be used to set a value to multiply the benefits by so they can be brought
into line with the costs for comparison.
4. Right-click the Object Type node and choose to add a New Property Group
Use New Property Group > Empty Group or From CM Panel depending on your preference .
SeeWorking with Property Groups for more details on Property Groups.

5. Select the Property Group and use the Selected Properties area to choose all the cost and benefit
properties you want to reference on the chart

6. Save your Site.

The Site is saved and t he Cost/Benefit Chart is created.
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Working with Vector Maps

Vector Maps require that you have a specific  Single Line Text property on your object which is
used to store a country code value, or a latitude/longitude value. The map will not work without

one of these codes.

Vector Maps enable you to highlight countries or places on a map so that the user can click through to see
more detailed information about that area.

You can use them on an Index Page , or on an Object Page to show locations that are associated to the
main object.

It works by using a single object in your model to represent an area on the map - either a country, or a
place within a country - that area is highlighted and is clickable so thata  supporting Object Page can be
used to show additional information.

Example

Use Location objects to highlight each country where your organization has an office , and
then use an Object Page for the Location  to show detailed information  about each one, such
as which Functions (associated) are performed there.

There are two types of map available, each with several different built ~ -in maps available:

1 Worldwide maps (used to show countries) : World, Europe
1 Country maps (used to show places): Belgium, France, India, Italy, Netherlands, Philippines, South
Africa, United Kingdom, United States.

If you want to view another map not currently on the list, please  review this list of available
maps, then raise a request with your Account Manager or with the erwin Support Team.
Highlighting countries on Worldwide maps

When using Worldwide maps , you must have a user -defined property on the object to store the country

code. This must be a Single -Line Text property.

The country code is a two -letter code which adheres to the SO 3166-1 standard, such as GB, US, FR. Read
more about ISO 3166 here , or here on Wikipedi a.

Highlighting places on Country maps

When using Country maps , you must have a user-defined property on the object to store the latitude and

longitude reference for the place you want to show. This mustbe a  Single -Line Text property.

The format for the value is ' [latitude],[longitude] ' - such as 48.856614,2.352222 for Paris.
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| ' )| Latitude values can be either North (N) or South  (S), while Longitude values are either East (E)
or West (W).

When entering these values in Evolve, please use a plus sign '+'instead of N and E  , and use
a minus sign ' -'instead of S and W .

What do you want to do?

Create a new Vector Map for your page

TN
( || These instructions assume that you have already created your page , including

\

any filtering you may want so that only the objects you want displayed are shown.

To create a new Vector Map for your page:
1. Ensure the Layout node for your element is setto List (Simple)
For an Index Page the Layout node is the one directly under the Object Type  node.
For an Object Page the Layout node is the one directly under the Association Type node
2. Right-click the Layout node and choose Add Behaviors > Maps > World Map ( jVectorMap)
A World Map (jVectorMap)  node is added below the Layout node
3. Select the World Map (jVectorMap) node and set the properties:
i Use the Map drop-down to select the map you want to use

ii. If you are using a Country Map  to show places in a country, use the Lat Lang field to enter
the Scriptname of the Property Type used to store the latitude/longitude value

iii. If you are using a Worldwide Map  to show countries, use the SO Code field to enter
the Scriptname of the Property Type used to store the ISO value

Always use lower case for Scriptnames.
4. Save your Site.

The Site is saved and the map is created.
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Working with Bar Charts (Simple)

The Simple Bar Chart behavior requires that you have a specific ~ Whole Number or Decimal
Number property on your object which is used to store the value you want displayed on the
chart.

The Simple Bar Chart behavior displays a simple bar chart on your Index Page , listing objects on the yaxis
and referencing number properties on the xaxis.

You can specify the maximum number of objects to display.

To create a Simple Bar Chart display on your Index Page:

1. Ensure the Layout node for your element is setto Layout (Empty)
2. Right-click the Layout node and choose Add Behaviors >Bar Charts > Bar Chart (Simple)

A Bar Chart (Simple) node is added below the Layout node.
3. Select the Bar Chart (Simple) node and set the properties:
i. Use the Node Name field to set the title of the chart as it is displayed in the web page.
ii. Use the Unit field to enter the na me of the unit that is displayed on the x axis.

iii. Use the Limit Number field to enter the maximum number of objects to display in the chart.
The name displayed on the legend at the top of the bar chart is taken from the ~ Name of
the Property Type you are using on the x axis.
4. Right-click the Object Type node and choose New Property Group > Empty Group

An Empty Property Group is added below the Object Type node

5. Select the Property Group and in the Selected Properties area, select the property you wantto base
the bar chart on

6. Save your Site.

The Site is saved and the bar chart is created.
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Working with Multi - Axis Bar Charts

The Multi -Axis Bar Chart behavior requires that you have a two specific ~ Whole
Number or Decimal Number properties on your object wh ich are used to store the values you
want displayed on the chart.

The Multi -Axis Bar Chart behavior displays a simple bar chart on your Index Page , which compares the
values of two properties of the objects referenced.
The chart has two scales, one for each property shown.
To create a Multi  -Axis Bar Chart on your Index Page.
Make sure you use the Filter Properties controls on the Object Type node o ensure you filter
the list of displayed objects so that not too many are returned.
Always use lower case to enter Scriptnames.
1. On the Object Type node, in the Selected Properties area, select the two properties you want to be
referenced on the chart

2. Ensure the Layout node for your elementis setto List (Empty)
3. Right-click the Layout node and choose Add Behaviors > Bar Charts > Bar Chart (Multi - Axis)

A Bar Chart (Multi -Axis) node is added below the Layout node
4. Select the Bar Chart (Multi -Axis) node and set the properties:
i Use the Node Name field to set the title of the chart as it is displayed  in the web page.

ii. Use the Value Axis -1 field to enter the Scriptname of the first property you want to be
displayed.

iii. Use the Value Axis -2 field to enter the Scriptname of the second property you want to be
displayed.

iv. Use the Axis-1 Unit field to enter the n ame of the unit that is displayed for the first property.

V. Use the Axis-2 Unit field to enter the name of the unit that is displayed for

the second property.

The name displayed on the legend at the top of the bar chart is taken from the ~ Name of
the Property Types you are referencing.
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Vi. Use the Direction drop-down to choose whether you want the chart to be
displayed horizontally or vertically

vii. Use the Legends Min/Max/Step  field to specify the scale of each axis, setting the low end
of the scale, the top end of the scale and the interval value - using for format
low:high:int,low:high:int

For example 0:100:10,0:500:100 means that Axis 1 starts at zero and ends at 100 with steps
of 10 units, while Axis 2 starts at zero, ends at 500 and has steps of 100.

viii. Use the Hide Empty Data check box to specify that the chart should not display any objects
where the two properties referenced have no value

5. Save your Site.

The Site is saved and the chart is created.
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Working with Simple Bubble Charts

A Simple Bubble Charts allow you to compare objects of the same type, by analyzing three levels of
data and using the values to affect the size and position of the representations on the chart.

One value is used to position the bubble on the X -axis, another value is used to position the bubble on the
Y-axis, while the size of the bubble is based on the third property.

With its accompanying Data Quality Chart , it also enables you to see where your data is incomplete, by
highlighting objects that do not have values set for the properties you are referencing.

If you want to use a Bubble Chart that visualizes data from associated or indirectly associated objects,

see Working with Cluster Bubble Charts

The Simple Bubble Chart requires three properties to compare - and these must all be
either Whole Number or Decimal Number properties - or they can be Drop -Down properties

where the Abbreviation contains a number

Why and how should you use one?

You should use a Simple Bubble Chart when you want to visualize a comparison between objects based on

three properties.
A typical example would be to have some Application objects with three useful properties:

1. Cost - a Whole Number property to represe nt the monetary cost of the application

2. Business Alignment - a Drop-Down property ranging from '0 - Unknown'to '5 - Very High', which
represents how important the application is to the business

3. IT Alignment - a Drop-Down property with the same range as Bu siness Alignment, which represents

how well aligned the application is to your current IT infrastructure, support and competencies

In this example the IT Alignment is used as the X -axis, the Business Alignmentisthe Y -axis, and
the size of each bubble is based on the Cost.

Where and when can you use one?

Use the table below to see where you can use a Simple Bubble Chart:
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Page .
Parent node | Tabs Number on page Editable
Type
Index Object Type | The chart must be in a Tab, but The Bubble Chart must be the N
o
Page node there can only be one Tab only item on the page

What would you like to do?

Add a Simple Bubble Chart to your page

\

These instructions assume you have an Index Page node , containing a Tab
Controller with one Tab that includes an Object Type node.

The result will be an Index Page including two Tabs, one which you created and named
Yyourself and that holds the Bubble Chart, and the second which is automatically created and is
used for the Data Quality Chart.

1. Select the Object Type node and ensure all the properties you want to reference are selected in

the Selected Properties area
2. If you want to filter the list of objects displayed, use the Filter Properties area to apply any filtering
3. Switch the Layout node beneath the Object Type node to Empty

To do this: Right -click the Layout node and choose Switch Layout > CW > Empty
4. Add the Bubble Chart (Simple) behavior to the Layout node

To do this: Right -click the Layout node and choose Add Behaviors > Bubble Charts > Bubble Chart
(Simple)

A Dashboard Bu bble Chart node is added
5. Select the Bubble Chart (Simple) node and configure the following settings:
0 Use the Node Name to set the title of the chart as it appears in the web page

o0 Use Circle to specify the Scriptname of the property you want to use to  affect the size of the
bubble

Always use lower case when referring to Scriptnames
0 Use X to enter the Scriptname of the property you want to use on the X  -axis
o0 Use Y to enter the Scripthame of the property you want to use onthe Y -axis

0 Use the three Data Quality settings to choose whether the corresponding properties are
Drop-Downs (Lookups) or number properties

Choose ‘Lookup _Abbreviation_Not o' if the property is a Drop -Down
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Choose ‘Not_Equal _To_o' If the property is a number
o Use Circle Unit to specify t he text to be displayed on the chart for the bubble size value

o Use X Unit to specify the text to be displayed on the X -axis - leave blank to use the Property
Type Name

o Use Y Unit to specify the text to be displayed onthe Y -axis - leave blank to use the Pr operty

Type Name

o Use Circle Intersection Object Type  to specify the Scriptname of the Object Type used on
the Object Type node

6. Save your Site.
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Working with Cluster Bubble Charts

Cluster Bubble Charts are similar to  Simple Bubble Charts Simple Bubble Charts , except they allow you
to visualize the properties of an Associated Object (directly or indirectly), or an Intersection Object

You can analyze three levels of data of the Associated Objects, using the values to affectthe  size and
position of the representations on the chart.

One value is used to position the bubble on the X -axis, another value is used to position the bubble on the
Y-axis, while the size of the bubble is based on the third property.

The way the Cluster Bubble Chart evaluates Associated or Indirectly Associated Objects is very similar to the
way Recursive Pie Charts  work, however, instead of creating one chart that you can drill down through,

it creates a number of Tabs , one for each of the items in the top -level Object List, and then creates a
Bubble Chart on each one .

The Cluster Bubble Chart does not display a Data Quality Chart like the Simple Bubble Chart does.
The Cluster Bubble Chart requires at least one Association Type  to exist - plus three
properties on the Associated Object to compare.

These properties must all be either Whole Number or Decimal Number properties - or they can

be Drop -Down properties where the Abbreviation contains a number

Why and how should you use one?

You should use a Cluster Bubble Chart when you want to visualize a  comparison between objects based on

three properties - but you want to take a higher -level view by using one or more associations.

A typical example would be like the example for Simple Bubble Charts, to have some Application objects

with three useful properties:

1. Cost - a Whole Number property to represent the monetary cost of the application

2. Business Alignment - a Drop-Down property ranging from 'O - Unknown'to '5 - Very High', whic h
represents how important the application is to the business

3. IT Alignment - a Drop-Down property with the same range as Business Alignment, which represents
how well aligned the application is to your current IT infrastructure, support and competencies
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In this example the IT Alignment is used as the X -axis, the Business Alignment is the Y -axis, and the size of
each bubble is based on the Cost.

However, where this differs from the Simple Bubble Chart is that instead of having one chart showing all
the objects, your Applications are associated to different Location objects  and you want to see a chart for
each Location showing only the Applications associated to it.

The resultis a Tab fo r each Location object and then a Bubble Chart for each showing just its associated
Applications.

While this example shows one level of association, you could make your chart use several, such as Location

> Organization > Application , or more.
Where and wh en can you use one?

Use the table below to see where you can use a Cluster Bubble Chart:

Page .
Parent node | Tabs Number on page Editable
Type
Index Object Type | You must have an empty Tab The Bubble Chart must be the N
o
Page node Controller on the page only item on the page

What would you like to do?

Add a Cluster Bubble Chart to your page

1. Create a new empty Index Page with an empty Tab Controller and an Object Type, both added to the
Index Page node, in that order

See Create an Empty Index Page for instructions

2. Select the Object Type node and use the Filter Properties area to apply any filtering
3. Switch the Layout node beneath the Object Type node to Empty

To do this: Right -click the Layout node and choose Switch Layout > CW > Empty
4. Add the Bubble Chart (Cluster) behavior to the Layout node

To do this.: Right -click the Layout node and choose Add Behaviors > Bubble Charts > Bubble Chart
(Cluster) .

A Bubble Chart (Cluster) node is added .
5. Add an Association node to the Object Type node

To do this.: Right -click the Object Type node and choose New Association > [object -type] >
Jassociation -type]
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A new Association Type node is added .

Ifyour chart examines indirectly associated objects , add all the additional Association Types

required, nesting them beneath each other

The last Association node you add is for the Object Type you want the bubbles on the chart to

represent.

6. Select the Bubble Ch art (Cluster) node and configure the following settings:

(o]

(o]

Use the Node Name to set the title of the chart as it appears in the web page

Use Circle to specify the Scripthame of the property you want to use to affect the size of the
bubble

This should be from the Associated Object - or, if you are referencing an Indirect
Association, from the last Associated Object in the path.

Always use lower case when referring to Scriptnames.

(o]

(o]

Use X to enter the Scriptname of the property you want to use on the X  -axis.
Use Y to enter the Scriptname of the property you want to use onthe Y  -axis.

Use the three Data Quality settings to choose whether the corresponding properties are

Drop-Downs (Lookups) or number properties.
Choose ‘Lookup _Abbreviation_Not o' if the prop erty is a Drop - Down
Choose ‘Not_Equal_To_o' if the property is a number
Use Circle Unit to specify the text to be displayed on the chart for the bubble size value

Use X Unit to specify the text to be displayed on the X -axis - leave blank to use the Propert y
Type Name

Use Y Unit to specify the text to be displayed onthe Y -axis - leave blank to use the Property
Type Name

Use Circle Intersection Object Type  to specify the Scriptname of the Associated Object

Type

7. Save your Site.
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Working with Radar Layout

A Radar layout is used to create a chart that displays three or more* Object properties on different axes
which start from the same central point.

A simple Radar chart uses one line to display the different properties of a single object (a Property Group ).

The Radar layout can also overlay multiple lines into a single chart to display the various properties of
an Object List . Each line is used to represent a different Object.

With the Radar layout, you can use one chart to visually consolidate multiple values of a single object, or
multiple values of many objects, against one another.

AN

(¥ *We recommend that 3 -10 properties or values are used per Object for clarity purposes.

Why and how should you use one?

Use the Radar lay out when you want to visually compare the different properties of a single object, or of
many objects, against each other.

You can use radar |l ayout I|ist in an index page or a single
Associ ati onpaged)or singl e

Next, add a properties group and under -Selected Propertie:
the radar layout. Please note that only integer properties (i.e numbers) can be represented in radar layout.

Where and when can you use o ne?

Use the table below to see where you can use the Radar Layout:

Page Type | Parent node Tabs Number on page | Editable
Index Page | Object Type node Yes - optional Any No
Object Page | Association Type node | Yes - mandatory | Any No

What do you want to do?

Use a Radar Layout

To create a Radar layout for the properties of a single object:

This is either the Object Type Node on an Index Page or an Association Type Node on an Object Page.
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Selection is only applicable for integer Properties as Radar Layout requires that only integer
values are used to create charts. Decimal numbers are permitted, however.

1. In Evolve Designer, locate the Parent Node that you want your Radar Layout to be applied to.

2. From the Layout drop -down menu, select Radar.

3. Inthe Selected Properties area of the Parent Node, select all the properties that you want to display
in the Radar.

4. Save and Publish your Site.

5. Navigate to the appropriate Object or Ind ex Page on your Site, and the Radar chart will be displayed.

To create a Radar layout for the properties of many objects:
This is either the Object Type Node on an Index Page or an Association Type Node on an Object Page.
Choose Switch Layout > CW >  Radar.

1. In Evolve Designer, locate the Parent Node that you want your Radar Layout to be applied to.

2. Right-click beneath the Parent Node Layout to change the Layout to Radar:

3. Inthe Selected Properties area of the Parent Node, select all the properties that  you want to display
in the Radar.

4. Save and Publish your Site.

5. Navigate to the appropriate Object or Index Page on your Site, and the Radar chart will be displayed.
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[ ' )| When inserting a Property Group, we recommend you only display a small number of properties
In any particular group - your page will look much better if you restrict the number of properties

in each one.
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Working with the Visual Identity
Layout

The Visual Identity layout is used to show a list of objects with  Visual Indicators  to represent some of their
properties, rather like you can with Shape Regions in CW Modeler.

The layout di splays each object as a rectangle, and then at the bottom of each shape you can show icons
to represent the values of one or more properties of your object.

It means you can build a dashboard -like page for a set of objects, highlighting important data abou t each
one, for example, showing a red circle if an object has a Business Risk of '3 - High' or a green circle if it has
a Business Risk of '1 - Low', and so on.

@ As for all Visual Indicators, the Visual Identity layout only supports lookup (drop-down) and check
box (true or false) properties of your objects.

In order to use the Visual Identity layout you must have configured a Custom Site to support the
use of Visual Indicators.

Why and how should you use one?

Use the Visual Identity la yout when you want to create a dashboard -like view of a set of objects or
associated objects, highlighting some of the important data about the objects displayed.

For example you could use the layout to provide an overview of the state of a set of Server o bjects, using the
indicators to show high -level data about each server.

Where and when can you use one?

Use the table below to see where you can use the Visual Identity layout:

Page Type Parent node Tabs Number on page Editable
Index Page | Object Type node Yes - optional One, or one per Tab | No
Object Page | Association Type node | Yes - mandatory | One per Tab No

Use the Visual Identity layout

These instructions assume you have already configured your Custom Site to support the use of
Visual Indicators for the Object Types and Property Types you want to reference.
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To use the Visual Identity layout:

1. In Evolve Designer, locate the parent node you want your Visual Identity layout to be  applied to
This is either the Object Type node on an Index Page or an Association Type node on an Object
Page

2. Inthe Selected Properties area of the parent node, select all the properties you want to use as
visual indicators

3. Switch the Layout of the node to Visual Identity
Right-click the layout beneath the parent node and choose  Switch Layout > CW > Visual ldentity

4. Select the Layout Visual Identity node

5. In the Properties List field, enter the Scriptname of the Property Type you want to be used as an
indic ator
You can reference multiple Property Types by entering the Scriptnames of each, separated using
comas

6. Save and Publish your Site.
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Working with Visual Indicators

Visual Indicators are small icons or images that are displayed to represent the values of properties of your

objects, rather like you can with Shape Regions in CW Modeler.

It means you could use a series of colored discs to represent Categories of an object, ort  ick and cross icons
to show whether a value is true or false.

They can be used with the Visual Identity layout , and with Custom Display Strin gs.

In order to use Visual Indicators though, you must deploy your site as a Custom Site , as the images
you want to use as your indicators must b e stored on the Evolve server and deployed with your Site when
you publish it.

Visual Indicators can only work with  lookup (drop -down) and boolean (true or
false) properties of your objects.

Configure your Custom Site to support the use of Visual Indicators

To use Visual Indicators on your Site, you must place image files in the correct location in a Custom Site
folder , and make sure they have the correct file names.

Folders

For each Object Type you want to use a Visual Indicator with, create a directory with the name as the
Scriptname of the Object Type in your Custom Site 'images' folder.

For example

<your-customsite-folder>/images/image_mappings/application
<your-customsite-folder>/images/image_mappings/process

Inside each Object Type folder, you must create additional folders for each Property Type you want to use as
an indicator, again named according to the Scriptname of the Property Type

For example

<your-customsite-folder>/images/image_mappings/application/validated
<your-customsite-folder>/images/image_mappings/application/type

Files
In each Property Type folder, you should place image files for each of the possible values that can be set.

Files should be named as follows:
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1 Use 'true' or 'false' for boolean Property Types
1 Use the Abbreviation for lookup (drop -down) Property Types.

If you want to show an indicator for the ' Undefined 'value for a lookup, create an image named
undefined'.

Evolve supports PNG, JPEG and GIF for the images, but as images look best when they use a transparent
background, we recommend using PNG files.

In the Site the images are re -sized to be displayed at 16x16 pixels, so we recommend creating squa re
images that will not be skewed when re -sized. For optimization reasons, we recommend creating images
that are already 16x16 pixels.
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Working with External Pictures

An External Picture layout is used to show a picture for each objectin a list, and  works by using a property
on your objects to reference images on the Evolve server.

B oMoz
T

Itis similar to the Image layout, except it is much better suited to displaying smaller images.

For example, you could have a number of 'Product' objects, each one with a 'logo’ property. If you upload an
image for each product to your Evolve server, you can enter the image name in the 'logo’ property for each
product, and using the External Picture layout, display that logo on an Index Page or Object Page (if listing
Associated Objects).

In order to use the External Picture layout, you must have a Property Type on your object which
can be used to store the image file reference . This must be a Single -Line T ext property.
Note the scriptname of this Property Type.

The External Picture layout also requires you publish your Site asa  Custom Site, and image files
must be uploaded to your Evolve server.

Why and how should you use one?
Use the External Picture layout when you want to display an image for each object in a list.
Where and when can you use one?

Use the table below to see where you can use an External Picture:

Page Type Parent node Tabs Number on page | Editable
Index Page | Object Type node Yes - optional Any No
Object Page | Association Type node | Yes - mandatory | Any No
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What do you want to do?

Use an External Picture layout

To use the External Picture layout:

1. Ensure you have a Single -Line Text Property Type on your Object Type where you can enter the
image name. If you do not have one, use CW Suite to create a new one.

For example, create a new Property Type titled 'logo’

Ifyou create the Property Type while Evolve Designer is open, you will have to close Evolve
Designer and re -open it in order for it fo recognize the new meta data.

2. Upload all the image files you want to use to the 'images' folder, or a sub  -folder within it, in
your custom Site folder

All standard web image formats are supported

3. For each of the obje cts you want to use an image with, enter the image file name in the new property
field.

What you enter here must be the full path to the image file, with the root being the ‘images’ folder in
Yyour custom Site folder. Therefore, if you uploaded your images  directly into the images’ folder, you
can simply enter the image file name. However, if you created a sub  -folder there, you should

enter: <sub -folder-name>/<image -file-name>, such as ‘logos/myimage.png’ .

4. In Evolve Designer, locate the parent node you want your External Picture page to sit beneath
This is either the Object Type node on an Index Page or an Association Type node on an Object Page

5. In the Selected Properties setting for the parent node, ensure you select the new Property Type
which stores the i mage reference

6. Right-click the layout beneath the parent node and choose  Switch Layout > CW > External Picture

7. Inthe Layout ID setting for the External Picture layout node, enter the scriptname of the Property
Type which stores the image reference .

8. Save and Publish your Site.

7=\
Please remember that now you are using a custom Site you must select that custom Site in

the Deployment node settings for your Site.
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Working with the Image Layout

An Image layout is used to show a picture to represent each object in a list, and works by using a property
on your objects to reference an image file on a web server.

Itis similar to the External Picture layout, except it is much better suited to displaying large images.

Users visiti ng your page can choose to navigate to the Object Page for that object, or can view the image in
fullscreen mode.

If one or more of the objects returned by the list do not have a value for the image URL property, that object
is omitted from the displayed | ist.

To display the same image as a property of your object in an Object Page, use the  imageFromURL Property
Group layout .
In order to use the Image layout, you must have a Prope rty Type on your object which can be
used to store the image file reference . This must be a Single -Line Text or URL property.
Note the scriptname of this Property Type.
The path to the file must be a full URL, such as:
http://www.mysite.com/images/myimage.  png

The following image formats are supported: PNG, JPEG, GIF.

Why and how should you use one?

Use the Image layout when you want to display a large image for each object in a list, whether that's a list of
objects on an Index Page, or a list of Associated Objects on an Object Page.

Where and when can you use one?

Use the table below to see where you can use the Image layout:

Page Type Parent node Tabs Number on page Editable
Index Page | Object Type node Yes - optional One, or one per Tab | No
Object Page | Association Type node Yes - mandatory | One per Tab No

What do you want to do?

Use an Image layout
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These instructions assume you have already created the Property Type to store the reference,
have populated the property for some of the objects, and have images stored in the locations

Yyou reference.

To use the Image layout:

1. In Evolve Designer, locate the parent node you want your Image layout to be applied to
This Is either the Object Type node on an Index Page or an Association Type nod e on an Object
Page
2. Switch the Layout of the page to Image
Right-click the layout beneath the parent node and choose  Switch Layout > CW > Image
3. Enter the scriptname of the Property Type you are using to store the image file reference in
the Image URL Property Scriptname  setting .
4. Save and Publish your Site.

The Custom Display String feature does not work with the Image layout.
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Working with View Box Layout

The View Box layout is a display function used internally by Evolve. This option is reserved and is not
intended for customer use.

What do you want to do?

Select an Alternative Layout
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Working with the Custom URL

LayO Ul 018024

The Custom URL layout is a display function used to display a URL property as a hyperlink, with a custom

display string for the caption.

1. Create a property group, and select a single property to

display in that group.

2. Use the Custom Display String to define the text to display to represent the link.

3. Select the Layout 'URL'

4. When the property is displayed in the page, it will

original URL.

Layouts
E! - D Object Pages
PG 'ﬁ] application
O Application
- ﬂ] attribute

rﬁ] businessrule
Fﬁ] cw_user_favorites

- jj] datastore
:ﬁ] diagram
& Fﬁ] document
=% O Document
5@ Layout Object Page

-

P OO O = WO
1 e g ) e e =

fal

2~ - Tabs

-4 Properties

88 G |
28 Genera

~--58 Description

- s Associations

w2 Project
- jj] entity
=0

now show the Custom Display String, but have the

Options [cwWebDesignerTreeNodePropertiesGroup] - General

Property Group Name

Identifier

|Genera\

IprOper‘ryGrnun_2134759443

Custom Display String
Layout

Display Full Width

|Open Documentl

URL

O

Selected Properties

Fig. URL Property

&M General

~[IName

~[JcCategory

“[OLocal Link - Deliverable
“[JLocal Link - Template

. [ZlWeb Link - Deliverable
“.[JWeb Link - Deliverable2
@ [JDescription

@-[JStatus

@-[JVersion

Related Topics

Select an Alternative Layout
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Working with Text Editor

The Text Editor has an HTML content editor for formatting rich text in multi  -line field. To use the Text
Editor, you must enable "Enhanced Multi -line Text Control" on the Property Type Page for the Memotext

Property Type . Without enabling this property, the Memotext field provides either read  -only HTML or
editable plain text fields.

Further, t he Memotext field on a site can be edite d in the text mode. However, you convert it to HTML in the
Object Explorer, you can no longer edit t he field.

Application properties: Activity Monitoring

Ganeral | Desrption | Detsds ML | mcomss Righvs | status | wersion |

Conwert To HTRIL - Riewvert to HTRAL
MemoText | Text Mode - Editable

Memotext (non enhanced)

MemoTexd : Text Mode - Ediiable

Agsociation o I
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Application properties: Activity Monitoring

B B#aic - Paragrapt = . A v B fUE

MemoText : HTML Maode - READ ONLY

Memotext (non enhanced)

MemoText : HTML Mode - READ ONLY

Assodiations oK I

You can edit the HTML content of your site with the Text Editor. Like Word processors, the Text Editor

offers additional formatting options .

Application properties: Activity Maonitoring - a Description
2SCp

Gereral Desroton | betaks | WML | Access itz | Status | Verson |
Edit ~ Inserld »  WView - Formal = Table » Tools =

Edt = Insert = WVigw = Format = Tabke = Tools ~
O o |Pusee - bk v um v MBI S8 % b Pamgaph - FonlFamiy - Foiszes - (A v Al v | & |6
X ® B JUSYx S~E"S=Es==sE L - — =
XhiH® B JUSXY x, S*"E“EXFFAE 6 I

Manage and monitor the cpcratlcmal activities of the
Manage and monitor the operational activities of the

enterprise
enterprise
P s tpan Waords: §
p L
e o | o | mew | Wirds: ¢

You can use the Text Editor to enter HTML code (including hyperlinks and images) , print multi -line text, and

copy and paste formatted text into other applications such as Microsoft Word.
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Content pasted will have the formatting simplified to match the capabilities of the Editor. Styles
such as Headlings will be mapped to equivalent HTML styles.

The Text Ediitor uses an open -source TinyMCE program and can be found in the following
location. Bin>WebDesigner>JS>External_async>TinyMCE

*TinyMCE is an open-source, platform -independent Javascript based WYSIWYG HTML editor
and is released as open software under the LGPL license

What Do You Want To Do?

Enable Enhanced Multi -line Text Editor for Internet Explorer

To use the Enhanced Multi -line Text Editor with Windows Internet Explorer, your server must enable a font

setting under Internet Options.

To enable Enhanced Multi  -line Text Editor for Internet Explorer:

1. Go to Start E enter control panel, and then select Control Panel .
The Control Panel window appears.

Adjust your computer's settings View by:  Category

System and Security 1 User Accounts

‘ Review your computer's status a E; Change account type
Save backup copies of your files with File History
Backup and Restore (Windows 7)

\" Network and Internet
View network status and tasks
7 Hardware and Sound
ﬂ' View devices and printers
Add a device

Adjust commonly used mobility settings

Appearance and Personalization

Clock and Region

Change date, time, or number formats

Ease of Access
Let Windows suggest settings

Optimize visual display

“~. Programs
[‘l’ Uninstall a program

2. Click Network and Internet

[Control Panel > Network and Internet

AN Network and Sharing Center
"} View network status and tasks ~ Connect to a network  View network computers and devices

et ‘_h Internet Options

Change your homepage = Manage browser add-ons  Delete browsing history and cookies
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3. Click Internet Options
Internet Properties dialog box appears.

‘}
General Security Privacy Content Connections Programs Advanced|
Home page
% Tocreate home page tabs, type each address on its own line.
http://www.msn.com/?pc=DCTE

Use current Use default Use new tab
Startup

(O Start with tabs from the last session

(@) Start with home page
Tabs

Change how webpages are displayed in tabs. Tabs

Browsing history

Delete temporary files, history, cookies, saved passwords, and web
form Information

[[]Delete browsing history on exit
Delete... Settings
Appearance

Colors. Languages Fonts Accessibility

oK Cancel Apply

4. Under Security, click Local intranet .

@
Genera\ Privacy Content Connections Pr(

Select a Lo hapge security settings.

‘. 4”

Internet |_Local intrane} Trusted sites  Restricted
sites.

5. Click Custom level .
Security Settings 2 Local Intranet Zone dialog box appears.

‘}, - -

Settings

< NET Framework
< Loose XAML
O Disable
® Enable
© Prompt
< XAML browser applications
O Disable
® Enable
© Prompt
«XPS documents
© Disable
©Enable
® Prompt
@ ,NET Framework-reliant components
= Permissions for components with manifests
@ Disable
O High Safety
&Run comnanents not sioned with Authenticode
<

*Takes effect after you restart your computer

Reset custom settings

Reset to: Medium-low (default) ~

0K

Reset...

Cancel

6. Scroll to Font Download and click Enable .
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2 Downloads
« File download
C Disable
® Enable
C Disable
® Enable
G Prompt

7. Click OK.
‘k

Settings

# NET Framework ~
«Loose XAML
O Disable
®Enable
O Prompt
« XAML browser applications
© Disable
©Enable
© Prompt
«XPS documents
O Disable
©Enable
® Prompt.
& NET Framework-reliant components
& Permissions for components with manifests
® Disable
OHigh Safety
&Run comnonents not sianed with Authenticade
<

*Takes effect after you restart your computer

Reset custom settings
Reset to: Medium-low (default) 5 Reset...

I OK I Cancel

A Warning about changing the settings appears.
‘b

'} Are you sure you want to change the settings for this zone?
4

Yes No

8. Click Yes.
9. Click Apply .
10. Click OK.

Enhance Multi -line Text Editor will now be enabled for use with Internet Explorer.

Restart Internet Explorer to apply this setting change.

Enable Enhanced Multi  -line Text Editing

7o enable the Text Editor:

1. Start the erwin Evolve Suite .
2. Click Model Explorer .
3. In the left pane, click the Design tab.
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Report

Administratior] -
Design |

4. Expand the required model. For example, EA Foundation 2 Sample Model .

|§;' Models

EI l{‘ EA Foundation - Sample Model
i Leagw Applications

Loagy Association Application Service
4w Association Business Rule Process

5. Select the required object type. For example,

er Models

EI Eg‘ E& Foundation - Sample Model
ok S pplications
gy Association Application Service
&g Association Business Rule Process
&gy Association DataStore Application

6. Inthe right pane, double-click Description

Application s.

The Property Type properties: Description dialog box opens.

' Name I

A

|i£| Average Rating
ategory
|iE]Code

|’=] Contact

_| Contract Type

_Icmcem
|i£] Description
[E] Docume; malion

_IEndofL

Eﬂ"ﬁdlbescmbonlheh |5lalus|varsnn|ﬂshry|

Name:*

5| Property Type properties: Description [m]
L

|besmpbon
Script Name:™®

[pescrapTION

Data Type:

[Muiti-ine text
32767 Maximum Number Of Characters
™ Enhanced Multi-line Text Control

[¥ Confirmed for translation
[~ Read Only

I~ Mandatory

Assodiations I oK I Cancel |

nelp ||

Ensure that Data Type is Multi -line text before selecting Enhanced Multi -line Text Control

check box.

Data Type:

Multidine text
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7. Under General , select the Enhanced Multi -line Text Control

The Enhanced Multi -line Text Control pop -up appears.

Z1Da
(EIEny

General |Desqvm

Name:*
Description

Script Name:™
DESCRIPTION

Data Type:

Enhanced Multi-line Text Control X

LN

Selecting this option enables the Enhanced Multi-line Text
Control for this Property Type.

Any existing data entered using this Property Type could be
displayed differently after this change has been made.

We therefore recommend that you review all previously
entered data before making any updates using the Enhanced
Muiti-line Text Control.

You can always switch back to using the standard control by
unselecting this option.

¥ Confirmed for translation

[V _Enhanced Multi-line Text Control

™ Read Only
[~ Mandatory
associations | ok | concel | e

8. After reading pop -up information , click OK.
9. Click OK.

10.
11.
12.
13.

14.

Name:®
[Pescroton

Scipt Name:™

Property Type properties: Description

Garea |pescrpton | e | stz | vrsn | sty |

==

Data Type:

¥ Enhanced w

¥ confir
I Read Only
I~ Mandatory

7 Muxmum Number OF Characters

i |

I ] o Help

Start Evolve Designer.

Click a model. For example, EA Foundation Sample Model

Click Site

check box.

Expand Site > Object Pages > application > Application > Tabs > Properties .

= ’\»? Slte_
+ lé Index Pages
=) Object Pages_
= FCJ apphcatlon_
= O Appllcatlon_

o= Tabs 4

58 Layout Object Page

- - Propemes-
oo

85 General

P
585 Details

=I=] Description

=8 Properties
S5 General

=0 .
22 Details

=
[==] Description

Click Description

15. Under Layout, select memotext .
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Property Group Name Description

Identifier propertyGroup_1169084468

Custom Display String

Layout memotext v

Display Full Width
play O

Selected Properties = OlGeneral
EADescription
Description
5 [Details
#Ostatus
[ IVersion

16. Click Save and then click Dynamic Site .

| ECORIO

e Before editing the HTML text field in erwin Evolve Web and erwin Web Modeler, ensure that
TinyMCE is available in Model Explorer.

To view TinyMCE in the Model Explorer

1. Start the erwin Evolve Suite .
2. Click Model Explorer .

3. Expand the required Model. For example, EA Foundation 2 Sample Model .

&) Models
o8
o eagw Applications

g Attributes

4w Business Rules

agw Calendars

4. Click Applications .

&) Models
(=41 EA Foundation - Sample Model
e

gy Attributes

-4g» Business Rules

5. Double click the application for which you want to view TinyMCE. For example, Salesforce .

W FrepaCommande Legacy
Iy Prod Monitor ERP
[ ]S alesforce ERP
W StockaMax Legacy
& SusCom Legacy

Application properties 2 Salesforce dialog box opens.
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Application properties: Salesforce o x

General |Descmuon} De!alsl Access R.ghﬂ smus| Versm| History |

Name:*

|‘§a\=sforc=

Enterprise Standard:

[3 - Approved standard =] Ed..
Category:

[Ere ~]_ Edit..
Code:

[sFo

Version:

[2008

Criticality:

[2 - Medium Criticality =] Edit..
Contact:

|M. Henri - thomas.henri@entreprise.com

Associations | oK I Cancel Help
6. Click Description

Application properties: Salesforce

General I Details I Access Rights | Status I Version I History I

The TinyMCE edit or opens.

Application properties: Salesforce o X
General Description | etais | Access Rights | Status | version | Hstory |
Edt v Inset~ View~ Format~ Tablev  Tools ~

* * Paragraph ~ FontFamiy ~v FontSizes ~ A ~ A ~ L B
XDh®® B JIUSXX E-E-vE=EFFE

= 6 I

Salesforce is a central piece of our IT landscape in so far as it offers all the sales related services to support our
sales processes.

P Words: 25
Assodiations I ,Tl Cancel l Help
Ensure that TinyMCE is available for selected object .

7. Click OK.

8. On the View menu, click Refresh List .
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View Action Tools Help
Refresh List F5
| Refresh All

List Detail >

v Object
Administration

Design

9. Close the Model Explorer.

To edit the HTML text field in erwin Evolve Web

1. Open the browser and login to erwin Evolve Web.

2. Click a model. For example, EA Foundation 2 Sample Model .

3. In the left pane, click Application .

4. Click Application List.

=

5. Click , to open the required application properties
6. Click the Edit icon to edit the Description .

00000

The TinyMCE editor opens for Description.

Description

Edit - Insert~ View Format - Table - Tools

Paragraph Verdana pt A - A
B B B J U S5 X x = = =
== 6 L

£ -

&

¥

Salesforce is a central piece of our IT landscape in so far as it offers all the
sales related services to support our sales processes.

25 WORDS POWERED BY TINY

7. Edit the Description and click the Save Changes icon.

z
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The Update Summary details appear in right pane.

8. Click Submit .

Property Changes

escription

Sal .
related services 1o SUPOT OUF Sales Processes.

orce is a central piece of our IT landscape in so far as it offers all the sales

70 edit the HTML text field in

erwin W eb Modeler .

1. Open the browser and login to e rwin Evolve Web.

2. Click a model. For example, EA Foundation 2 Sample Model .

My Stes

4. Click Application Architecture

5. Click the Edit Diagram In Web Modeler

icon.

The available draft diagrams appear.

Available drafts for this diagram

Application [chitecture

Application Architecture

o0
Q0
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6. To open any draft diagram in erwin Web Modeler, Click o

The erwin Web Modeler editor opens in a new tab with the predefined Shape Palette of th

chosen.

7. Select the required application object. For example,

8. Click o

9. Scroll to Description and click the Edit icon.

[ Description] ’

Salesforce is a central piece of our
IT landscape in so far as it offers
all the sales related services to
support our sales processes

to view the object properties.

TinyMCE dialog box opens to edit the Description.

Description

ur sales processes

¥ D EMBE B I U S X% EviE E(ss =S

Update

central piece of our IT landscape in so far as it offers all the sales related services to

Cancel

10. Edit the description as you want and click Update .

11. Click to publish the diagram.

12. Click Confirm Publish

Would you like to publish the diagram?

Cancel Confirm Publish

Salesforce .

e template

Once the diagram is published in the erwin Web Modeler, it can be accessed from the Modeler in

the desktop application .

Review and Approval Notifications

If Workflow has been enabled for your site, when a text field has been altered using the Text Editor and a

user desires to save the changes made, the designated Approver is sent a 'Pending Changes' notification

email. Any changes ma de will not be implemented until authorized by the Approver. The Approver will

receive an email stating: 'This property contains HTML content. Please review this change in Evolve'. -

prompting them to access Evolve and assess the detail of all HTML changes

made. This content is not
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included within the email as email systems will often display this incorrectly and cause confusion for the
user.

See Working with Tasks

erwin Evolve 2 User Help Guide
Data Visualizations



Displaying Diagrams

Display a CW Modeler Diagram

Any diagram in your model created in CW Modeler can be displayed in your Evolve Site.

You can display diagrams on any Object Page where the focus is the Diagram Object Type, or on Object
Pages where the focus is a different Obj ect Type, but a Tab is used to display diagrams the object appears
on or details .

You can also display diagrams on Index Pages where one or more diagrams are returned. For performance
and usability reasons it may not be appropriate to display multiple diag  rams on one Index Page, however you
could easily use the page filters so that only one diagram is returned in the results.

The default method for displaying CW Modeler diagrams is to use the ~ CW Modeler Diagram behavior, but
you can experiment with a newer behavior - Vector (HTML5) - which provides improved quality and scaling.

Display a CW Modeler diagram
These instructions detail how to display a CW Modeler diagram  on an Object Page for the
Diagram Object Type.

You can of course show Visualization diagrams in other places, such as below an Association

node in a Tab on an Object Page, or below an Object Type node on an Index Page.

To display a CW Modeler diagram:

1. In Evolve Designer, expand the Object Type node
2. Right-click the Layout node and select Switch Layout > CW > Diagram

A Layout Diagram node is added .
3. Right-click the Layout Diagram node and select Add Behaviors > CW > CW Modeler Diagram
The CW Modeler Diagram node is added .
4. Select the CW Modeler Diagram node and edit its properties:
0 Use Full Screen to specify if the diagram should be shown in full -screen mode.

0 Use the Diagram Popouts area to specify any Diagram Popouts you want to configure for

this page .

5. Save and Publish your Site.
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Display a Visualization Diagram

This page explains how to display Diagram Designer Visualization diagrams in your Evolve Site.

Visualization diagrams are typically used to visually -represent an object and its  relationships to other

objects, allowing you to see a specific object in context.

However, rather than being a fixed diagram created in CW Modeler, they are  automatically generated  at the
time of viewing.

Visualization diagrams are created as ‘'layouts' in  Diagram Designer. The layout defines which Object Type is
the focus of the diagram, which other Object Types and Associations should be shown, and how the diagram
should be organized, but it does not specify which object instances should be shown.

In Evolve, you can configure a page to show a diagram generated from one of these layouts, resulting in a
dynamically -generated view of an object in context.

You most commonly display Visualization diagrams on  Object Pages, where you want a visual
representation o f the subject of the Object Page. However you can also display them on Index Pages.

This Help does not explain how to create Diagram Designer layouts.

Evolve only supports Diagram Designer layouts which have one object instance  as the focus.

Display a V isualization diagram on your web page

These instructions detail how to display a Visualization diagram  in a new Tab on an Object
Page.

You can of course show Visualization diagrams in other places, such as below an Association

node in a Tab on an Object Page, or below an Object Type node on an Index Page.

To display a Visualization diagram on your web page:

1. In Evolve Designer, expand the Object Page node where you want your diagram to be displayed
2. Right-click the Tab node and select Add Layout >C W > Diagram

The Layout Diagram node is added .

3. Right-click the Layout Diagram node and select Add Behaviors > Diagram > Visualization
(Automatic Diagram)

The Visualization (Automatic Diagram) node is added .

4. Select the Visualization (Automatic  Diagram) node and edit the settings:
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Use Diagram Design Name  to select the Diagram Designer layout you want to use on this page. Only
layouts focused on the same Object Type as the Object Page are listed

Use Display Mode to choose how you want the diagram to be displayed, either constraining it by

diagram height, or displayed in full -screen mode.

5. Save and Publish your Site.

Related Topics

Create a Visualization / Automatic Diagram
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Display Object Data with Diagram
Pop-outs

This page explains how to create and use Diagram Pop -outs to display the data behind objects that appear

on diagrams.

‘ You can use Diagram Pop -outs with all display Layouts in Evolve.

Seelayouts and Behaviors Explained for a full list of supported Layouts.

Diagram Pop -outs are used to display information about objects that appear on a diagram.

When a user clicks on an object on a diagram in the Site, a pop -out panel showing the object's details is
displayed on the right of the browser window.

Diagram Pop-outs are completely customizable , so you can choose exactly what data you want to show for
any given object, and you can even display different pop -outs depending on the Category  of the object.

Pop-outs are constructed in a similar way to Object Pages, although you cannot use Tabs , but as such t hey
can include properties of the object |, lists of associated objects , as well as some visualizations . Behaviors

are not supported in Diagram Pop -outs.

Like Object Pages, Diagram Pop -outs are Object Type specific , so you must create a pop -out for each

type of object you want to view the details of.
There are two steps to getting Diagram Pop -outs working on your Site:

1. Create a Diagram Pop -out
2. Configure a page to use a Diagram Pop -out.

(' )| Ifyour Site was created in Evolve 2.2 or earlier , you must enable Diagram Popouts in Evolve
Designer before you can create any.

70 do this:

. Open your Site in Evolve Designer
ii.  Right-click the Site node and select Add Diagram Popout Node

The Diagram Popouts node is added to the bottom of the Site tree.

What do you wartb do?

Create a Diagram Pop -out
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To create a Diagram Pop -out:

1. In Evolve Designer, right -click the Diagram Popouts node and select Add Object Page for Object
Type > [object type]

A node is added for the Object Type you selected
2. Configure your pop -out to display some object data and/or associations

You configure the pop -out to display data in a similar way to how you build an Object Page,

using Property Groups and Associations . However, there is one important difference to an Object
Page - you cannot use Tabs .

You can use multiple Property Groups, and you can use multiple Associations.

See here for information on using Property Groups

The Property Group Layout FlatList’ particularly useful on Diagram Pop -outs, as it combines multjple
properties in a simple display format.

3. See here for working with layouts and behaviors for Associations

4. When you have completed the configuration of your pop -out, Save it.

In order for your pop -out to display on a diagram page, you must configure the page to use it.

Configure a page to use a Diagram Pop -out
Even if you have created a Diagram Pop -out, you must configure individual pages in your Site to use it.
You can display a Diagram Pop -out on any Object Page or Index Page  which is configured to display a
diagram.
To configure a page to use a Diagram Pop -out:
1. On your page, select the diagram behavior node you want the pop -out to work with
The CW Modeler Diagram, Vector (HTML5) , or Visualization (Automatic Diagram) node

2. Use the Diagram Popouts area to choose the pop -outs you want to use for different Object Types
that appear on the diagram

Use different rows to specify different pop -outs for different Object Types or Categories of the same
Object Type.

i Use the Object Type drop-down to select the Object Type you want a pop -out for
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ii. Use the Category drop-down to select the Category of the Object Type you want the pop -
out for - or leave the Category as ' UndefinedValue ' if you want your pop -out to apply to all
instances of the selected Object Type

iii. Use the Diagram Popout drop-down to sel ect the specific pop -out you want to use for the
Object Type and Category combination you have chosen

3. Save and Publish your Site.
Create Category -specific Diagram Pop -outs
You can show different pop -outs for different Categories of the same Object  Type.

To do this, create multiple pop -outs for one Object Type, then, when configuring your page to use the pop -
outs, choose different pop -outs for different Categories of objects.

If you want to have just one Category of Object Type showing a different po  p-out to the others, create a
generic pop -out and set it to 'UndefinedValue' on the diagram page, then specify the Category pop  -out just
for that specific Category.
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Display a Diagram on the Home Page

of your Static Site

If you publish your Site as a Stat ic Site, you can create a special home page which displays a CW Modeler

diagram.

This feature does not work with Dynamic Sites .

To display a diagram on your Static Site home page:

1. Create a new Diagram Index Page
2. Enter 'home' as the Page Name
3. Ensure your page filter is configured so that only one diagram is selected

For example: 'ID = 12’
4. Save and Publish your Site .
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Displaying Vector (HTML5) for
Displaying Diagrams

This page explains how to display CW Modeler diagrams in Vector (HTML5) format in your Evolve Site.

Vector (HTML5) diagrams introduce a new method for displaying CW Modeler diagrams, bringing increased

load performan ce, better picture quality and perfect scaling.

Use the Vector (HTML5) Diagram display
To use the Vector (HTML5) Diagram display:

If you want to compare the appearance of the Vector (HTML5) version of your diagram and the
original CW Modeler version, you can display both versions in your page. To do this, each

diagram must be displayed in a different Tab. Ensure that you enter a specific Layout ID for

each.

This is a useful way to provide us with feedback  about the differences you experience.

1. Open one of your existing Diagram pages.

2. Add a new behavior to the Layout Diagram node you want to change, ensuring you choose the Vector
(HTMLS5) option.

3. Delete the existing CW Modeler Diagram node.

Support for diagram elements

The Vector (HTML5) diagram behavior supports all diagram elements typically available to CW Modeler
diagrams, except for the following:

The following elements are  NOT supported:
1 Association Type Regions
The following elements are  PARTIALLY -supported:

1 Version Control (all items excep tfor the Detailed Object section)

1 Free Text (only Free Texts referenced on the palette)
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(1) IMPORTANT

Vector (HTML5) Diagrams will not correctly display any diagram element where the formatting of
the element is applied directly on the canvas

Only formatting applied to items on the  New Objects Palette of the corresponding template
diagram are displayed correctly.

Diagram Shapes

There is partial support for available for the following diagram shapes:

006 DDDCDE‘
EIEIC D OoQIoCed Dl
CHOUOOOOOO®®®
oA oOdUanNV O
{5 [ [0 (o] (o [ (] (o] [
FHHENOO0OIE a0
oo C O

RED Not Supported

Supported with differences to the original CW Modeler
BLUE

diagram.

| | Please note that due to the rendering limitations of Internet Explorer 9 and 10, using shapes with a
dashed outline may prevent the diagram from rendering properly

Lines and Connectors

All lines and Connectors are supported.
Shape Regions

The following table shows the support for shape regions:
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Region Level

Label

Association Type

Property Value

Property Value (Custom)

Property Visualization using Reference property

Property Visualization using Palette value

Explosion with rule and category

Property gauge using a reference property

Property gauge using Palette

Property Gauge as date range

Explosion

Explosion with rule

Navigation
)
\/ A yellow triangular ( ! ) Warning icon will display next to the action buttons in the top right hand

corner when:

1 If there is misalignment between the Template Palette and the Diagram Palette. However,
the icon will not display if the misaligned objects in the palette use names that have
previously been accepted for aligned objects, even if their settings have been changed.

1 A diagram uses unfinished or missing connectors. Close and reopen the diagram in

Corporate Modeler . If the Warning icon remains, this is likely due to another issue.

ﬂ Missing Shapes create a Broken Layer. Close and reopen the diagram in Corporate Modeler
. If the Warning icon remains, this is likely due to another issue.
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Please be aware that certain fonts are not supported by all browsers. When using the HTML5
Canvas, some fonts will therefore be substituted for alternative styles, depending on your

browser type .

Publishing Static Sites

If you only use the Vector (HTML5) behavior to display diagrams in your Static Site, you can tell Evolve to no
longer generate image files of the diagrams in your repository when you publish the Site.

Generating diagr am image files is often the most time -consuming part of publishing a Static Site and they
are not needed for the Vector (HTML5) behavior, so choosing not to export them can significantly speed up
publication.

Use the Export Diagram Images option on the Site node setfings  to disable diagram image generation.
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Editing Business Process Diagrams

Please check with your Administrator that firstly, your Server and  Internet Browser meet the
necessary system requirements to use BP modeler . Secondly, check with your Administrator

that the eModeler feature is enabled.

BP modeler is used to both edit and create Process Diagrams online, using predefined Dynamic Templates

and Themes.
Save & Publish
Title Bar Help Toggle
{ r Exit Editor
o Rent a Movie (Process Capture) ADMIN
2 4 ? % DIAGRAM
% PROPERTIES
Name Rent a Movie (Process Cap
Tithe Rent a Movie (Process Cap
Undo / Redo Buttons
Zoom Controls Extemnal Event
-—— Canvas Area—- Editor Menus ——
7 Draft Status S
+ Draft Saved ACTIONS

The different features within the Editor are detailed below:

Title Bar Displays the Diagram Draft and related Rent & Movie (Process Capture)

Template Names

Zoom In, Reset Scaling, Zoom Out and Full +
Zoom Screen. =
Controls Click and move the 'Radar’ view to zoom =
around the diagram. A
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Canvas Undo, Redo, Save & Publish, Help and Exit
R ep > 4 ? x
Controls Edit Mode.
[ = ]
=
) Home to the different BP Modeler
Editor Menus ) )
Panes: Diagram, Appearance, and Actions.
Canvas Area The area where the.edltfad/created ¢ Canvas Area y
Process Diagram will display. l

Navigation

BP modeler controls that can be used when editing a diagram.

Click Summary
Mode Click Behavior
Type
Si Displays the Context pane for that Shape/Connector in the Menu pane (edit properties,
ingle -
connect another Shape, add/remove Swimlane).
Standard
Opens the Properties sub-menu and enables the Name and Title fields for entering or
Double L .
editing the Shape/Connector's name.

Keyboard Shortcut Summary

Keyboard Shortcut Behavior
Ctrl+ + Zoom In
Ctrl+ - Zoom Out
Esc Deselect all shapes
Ctrl+z Undo the last change
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Keyboard Shortcut Behavior

Ctrl+Y Redo the last change
Enter Save Diagram/Shape/Connector changes when  editing properties
Delete Deletes selected Shape(s)/Connector(s)

BP modeler s a licensed application. In order to use it, additional licenses are required on a
per user basis.

Drafting & Publishing

When BP modeler is enabled for an Object Type, 2 menus are created; a drafts menu and a published

menu.

Drafts Menu

The Drafts menu displays all the current drafts for the specified object type. Drafts can be viewed in Tile
view, or Full view. Hovering over the draft will reveal the draft contr  ols:

0000

Process Diagram

These controls allow you to view, edit, delete or open the diagram in the Object page.

Published Menu
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Process A
Tile Full )

Tab0

Process?2

=t

Process Diagram

Process

Published

The Published menu displays all the published diagrams for the specified object type. Drafts can be viewed
in Tile view, or Full view. Hovering o ver the draft will reveal the diagram controls:

Process Diagram

These controls allow you to view, edit or open the diagram in the Object page.
Creating New Diagrams

In the top -right of the Drafts and Published pages there is an icon that can be clicked to create a new

diagram:

There are currently no diagrams published for this object.

Get started here.
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Duplicating Diagrams

To duplicate diagrams, edit an existing diagram and navigate to the Actions menu:

ACTIONS

& w & &

Clicking the first icon will result in a duplicate of the current draft being created.

What do you want to do next?

Enable BP modeler

BP Modeler is not enabled by default.

7o Enable BP modeler:

The Server Configuration Dialog will open.
BP modeler will be enabled for use on your Site.

1. Open Evolve Designer and select the Evolve Designer Models launcher dialog, click on the  Server
Configurat ion button:

Do®0Oe

2. Open the Features tab and check the Enable BP modeler check box.

| Server | Authentication |Wu:rrlcﬂu:rw Features

[l

Enable Diagrarm Editor

3. With the function enabled, Open the Dynamic Deployment tab and click the Save button to commit
the changes to your Site.
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Adding BP modeler Pages to Object Types

If you already have eModeler enabled (from version 3.1 or lower) for an Object Type you will
need to remove or delete the eModeler nodes prior to completing these steps

In Evolve Designer, right click on Object Pages and hover over Add BP modeler Page for O bject Type to
expand the list of Object Types. Simply click an object type and Evolve will automatically add the pages to
view BP modeler drafts and published diagrams.

Layouts Options [cwWenDesgner TreeNodePagesSe

Node Name
o (1) Index Pages

py—
CBE agaOnect Page For Object Type

AdsObject Page
Add eNodeier Page For Object Type ’
Generaze Object Pages Contents - 5tat Maoda Orily

o Expand

Collapse

& (70 dagram

ment

eresult Flow

tresult

Framawork Heip
T Portfolo
Indicatee

1} organization
& {1l process

=1 project

| technology

&) Temgiate Nodes
- Lt

Once your configuration is complete, publish your Evolve site as usual.

Configuring a dynamic template to support BP modeler

You should already have a Process diagram template configured in CW Modeler that offers the
shapes you would like to use in your Process diagram palette.

Launch Evolve and login as a System Manager and you will now have an Administration menu, under
which you will see Dynamic Template Editor
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€% Administration

Create a New Diagram from an Existing Template

To Create a New Diagram from An Existing Template:

A sub-menu for that process will open, listing three options to sele  ct from:

The Process Flow page will open.

The BP modeler canvas will open and you can begin to create your new Process Diagram.

1. Open Evolve and click on the Processes tab.
2. Click on the All Processes option to display a list of all available processes.
3. From the list displayed, select the Process that you wish to build a Diagram for.

o Process
o0 Process Flow
o Properties

4. Click on the Process Flow option.
5. Click on the Create a new diagram based on the template [Template Name] link at the top of the

screen.
Create a Basic Linear Process Diagram

A basic Process Diagram will capture three simple steps: The  Event that triggers the process,
an Activity or Decision, and a Result.
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7o Start Your Basic Process Diagram:
See Create a New Diagram from an Existing Template.
The Shape will be transferred to the Canvas Area.

The description will be added to the Shape:

EXTERNAL EVENT

Process Trigger
PROPERTIES (Event)

Process Trigger (Evem)|

SHAPES

External Event

The Next Shapes available for selection will then display in the Shape Menu Pane:

SHAPES

The second Shape will be transferred to the Canvas Area and connectto  the existing Event Shape:

Process Trigger
(Event)

¥

The Next Shapes available for selection will then display in the Shape Menu Pane:

erwin Evolve 2 User Help Guide
Displaying Diagrams

177



Process Externsl Result

Internsl Result

Connector

This final Shape will be transferred to the Canvas Area and connect to the existing Activity/Decision Shape:

Process Trigger '\ Activity / Decision
(Event) } >

/

¥

Your basic Process Diagram is now ready to be saved.

See Saving your Work in eModeler.

1.
2.
3.

© 00 N O O

Open eModeler and select the appropriate Process from which to create the new Diagram.

In the Shape Menu Pane, click on the appropriate Event Shape.

Add a description or title to the Shape by entering d etails into the Name field in the Properties Menu
Pane.

. Click on the green circle containing a tick, the Validate your Changes button, displayed beneath.

Alternatively, press the Enter button on your keyboard.

. Select the next Activity/Decision Shape by cli cking on it.
. Add a description or title to the Shape and save it.

. Select the available Result Shape by clicking on it.

. Add a description or title to the Shape and save it.

. Save your Diagram.

Saving your Work in eModeler

To Save a Draft

Drafts save automatically as they are edited, so you will never have to worry about accidentally closing the

browser and losing all of your changes.

To Do Menu Pane
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There is a fourth, hidden, menu pane called To Do, which only appears if there are any aspects of your

Diagram requiring action. The To Do menu will list these actions and the Shapes relating to these tasks will

be highlighted by a red border. Users will be prevented from saving your work until these actions are
addressed.

O setName property on Shape

(O Set Name property on Shape ® Y

Once the actions have been co mpleted, you will be able to successfully save your work.

1. Select a Task from the list to be taken to the relevant aspect of the Diagram requiring action.

Add Descriptions and Properties to a Shape

To Add a Description or Property to a Shape:

As soon as new information is added to the fields, a green circle containing a tick, the Validate your
Changes button, displays beneath.

A

PROCESS

Process Trigger
PROPERTIES (Event)

Name Process Trigger (Event)

Process <Extemll Result

¥

Internal Result S -
<
\ C
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eModeler supports all diagram elements typically available to CW Modeler diagrams, except for
the following Property Types:

1 Date Range
1 Distribution Properties
1 The use of Memotext in HTML5

For a full list of the existing Regions supported, see: Shape Regions.

1. Click on the Diagram tab to select the required Shape and add it to the Diagram.

2. In the Properties section of the Diagram tab, enter the desired information into the Name and Title
fields.

3. Click on the Validate your Ch anges button to save your new description to the Shape.

Create a Connection between Shapes:  Add Alternative Branches (Simple )

There are three ways to create a connection between two shapes. Each method is described below.

To Create a Connection Between Two  Shapes, Either:
The Shape will be highlighted by a solid border to indicate that it has been selected.
A Connector linking the Shape to your mouse pointer will appear.

The linked Connector follows the mouse pointer. The Connector will turn red when encountering Shapes

that cannot be connected to, and green with those Shapes that it can.
The Connector will link the two Shapes, indicating that a connection between the two has been made.

1. Select the first shape by clicking on it.
2. Click on a Connector fro m the Shapes Menu pane.
3. Move your mouse pointer to the Shape you would like to connect to (target Shape).

4. Click on the Canvas to end Shape selection.
OR
The Shape will be highlighted by a dashed border to indicate that it has been selected.
A Connector will link the two Shapes, indicating that a connection between the two has been made.

1. Click and hold (long -click) on the first Shape to select it.
2. Double-click on the target Shape.

OR
A Connector will link the two Shapes, indicating that a connec  tion between the two has been made.

1. Hold down the Shift key and click on the first Shape to select it.
2. Double-click on the target Shape.
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For Shapes that are not rectangular in nature, Connectors will connect to the Shape's
boundary, and not directly to t he Shape itself.

Create a Connection between Shapes: Add Alternative Branches (Multiple)

There are three ways to create connections between multiple Shapes. Each method is described below.

To Create a Connection Between Multiple Shapes:

The Shape will be highlighted by a solid line to indicate that it has been selected.

Each additional Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.
Connectors will link the Shapes, indicating that connections have been made betwe  en them.

1. Select the first shape by clicking on it.
2. Hold down the Shift key and click on the next shape.
3. Double-click on the final target Shape to end the multiple selection.

OR:

The border of the Shape will be highlighted with a dashed border to indicate t  hat it was been selected.
Each additional Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.
Connectors will link the Shapes, indicating that connections have been made between them.

1. Select the first shape by clicking and h olding on it (long -click).
2. Click on the extra Shapes required.
3. Double-click on the final target Shape to end the multiple selection.

OR:
Each Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.
Connectors will link the  Shapes, indicating that connections have been made between them.

1. Press and hold down the Shift key.

2. Click and drag your pointer over the area containing the Shapes to be selected.

3. Once you are happy with the Shapes selected, release the Shift key stop drag ging across the area.
4. Double-click on the final target Shape to end the multiple selection.

For Shapes that are not rectangular in nature, Connectors will connect to the Shape's
boundary, and not directly to the Shape itself.
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Delete Shapes from the  Diagram

To Delete a Single Shape or Connector from your Diagram:

The Clear Shape icon will display:
The Shape or Connector is deleted.
1. Select the Shape or Connector.
2. Click on the Clear Shape icon
To Delete Multiple Shapes or Connectors from your Diagram:
The Clear Shape icon will display.
The Shape or Connector is deleted.
1. Select the necessary Shapes or Connectors.
2. Click on the Clear Shape icon.
To Delete a Swimlane from your Diagram:
The Swimlane will be deleted but the Shape[s] attached to it will remai n.

1. Select the Swimlane and proceed to delete as with a Shape or Connector.

Assign Swimlane Elements to your Process

It is possible to group or assign various aspects of your diagram to a particular Swimlane element. Assigning
Shapes to a Swimlane can provi de clarification about which organizational roles or functions are responsible

for which parts the process being captured in your diagram.

To Assign a Shape/s] to a Swimlane:

1. Click on the required Shape[s] that you would like to assign.

2. In the Selection Me nu Pane, a Swimlane Sub -menu pane will appear. The sub -menu will use the
same title as the element placed inside the Swimlane category in the Diagram Template Editor. In
the example below, the Swimlane element is 'Organization’.

3. You will be prompted to eit her search for or create a the new group to assign the Shapes to:

ORGANIZATION

Search or Create
The previously selected Shapes will be assigned to the new group.

1. Select (or create) the desired group.
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To Change the Name of a Group/Swimlane Element:

A solid border will appear around the element Shape (Organization grouping).
The Swimlane (Organization) sub -menu will appear in the Editor Menus area.
The new description will be added to your Shape.

1. Select the Swimlane element by clicking on it.

2. Enter the new element name into the properties field provided.

3. Click on the green Validate your Changes button to save your new description to the Shape.
Alternatively, press the Enter key on your keyboard.

Operations Team
= w - b
Mext Shape C: Mext Shape G
Goods itemized, ORGANIZATION Goods de:med
stock updated slock updaled
. Operations Team| X B
- b 4 -
Next Shape D i Mext Shape D:
Goods dispatched Operations Team Goods dispatched

To Remove a Swimlane from your Diagram:

A solid border will appear around the element Shape (Organization grouping).
The Swimlane (Organization) sub -menu will appear in the Editor Menus area.
The Swimlane element is removed from your Diagram.

1. Select the Swimlane element by clicking on it.
2. Click on the Clear Shape icon located in the in the Properties section of the pane:

]

Change the Appearance of your Diagram

When creating your Diagram, it is possible to adjust the both the orientation of the Diagram and the Theme
used.

To Open the Appearance Options

The Appearance M enu options will display:
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APPEARANCE

Dev?2 2

1. Open your Diagram Draft and click on the Appearance Menu Pane.
2. Select the appropriate option.

To Change the Orientation of your Diagram:

Process Trigger | Activity / Decision

o B

y

—rl'

Alternatively;
Iy
Process Trigger
(Event)
Y
4
¥
-
h Activity / Decision
v i
Resuit

)
y

4

The Diagram will change orientation accordingly.

1. Open the Appearance Menu Pane.

2. Click on the Left to Right icon to display your Process Diagram from left to right across the screen:
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3. Click on the Top to Bottom icon to display your Process Diagram from the top to the bottom of the
screen:
To Change the Theme Used b y your Diagram.

A list of Themes available for selection will display in the Theme sub  -menu.

Dev 1 é
Dev 2 2

1. Open the Appearance Menu Pane.
2. Select your chosen Theme by clicking on the relevant pane:

Exit eModeler

To Exit the Application:
The screen returns to the previous Process Summary page.

1. Click on the Close Edit Mode icon at the top of the screen:

] - ? x
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Using Web Modeler

Overview of Web Modeler - Editing

Diagrams Online

Please check with your Administrator that f  irstly, your Server and Internet Browser meet the
necessary system requirements to use Web modeler . Secondly, check with your Administrator

that the Web Modeler feature is enabled.
Web modeler is used to both edit and create any Evolve Diagram online.

f New Draft Diagram

Fu?a*-u'\ /EE

Diagram Draft Diagram
Shape Palette \ Title Manager
Diagram
Operations
ervice Catalog Service Catalog
Level - Level 2
Shape Tools /
and
Service Catalog  Existin Diagram Settings
e e Diagram
Surface
T Pro
Diagram
Palette
: ‘ Zoom Controls
[ 100% — ——@—— 4+ & Q

The different features within the Editor are detailed below:
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Diagram Title

Editable title for the diagram, this
differs from the diagram name,
which must be unique

Click to rename the title

Zoom Controls

Zoom % - Click to choose presets
Zoom inandout - [+]and [ -]
Zoom Slider

Radar button
Click and move the 'Radar' view to

. Zoom Options
zoom around the diagram.
All can be collapsed to a single 150% — —@— + ¢ Q
magnifier button.
Shape Palette
The Shape Palette contains all the
shapes that can be used on the Service Catalog Service Catalo
diagram. - LE!‘E' ] - LE!‘E' .L-l
Drag and drop the shapes from the
alette onto the diagram surface
Shape Palette P 9
Service Catalog Existing
Note that lines / connectors are - Level 3 Service
drawn from the (+) buttons around
the sides of a selected shape.
Future Service Process
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o _
3 rocess O
% Undefined -
a Undefined -
$ tan
Undefined -
) Home to the different Web Modeler
Shape and Diagram ) ) e
Panes: Properties, To Do, Settings
Tools
and Styles. )
Save
The area where the edited/created T
Canvas Area . . “+—— Canvas Area —*
Process Diagram will display. l

Navigation

Web modeler controls that can be used when editing a diagram.

Click Summary
Mode Click Behavior
Type

Standard | Single

Selects a shape and updates the "Shapes and Diagram Tools" pane for that
Shape/Connector, if the pane is open.
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Mode Click Behavior
Type

Boubl Opens the "Shapes and Diagram Tools" pane, if it is closed, and navigates to the
ouble

Name and Properties tab. For easy access to the object details.

Keyboard Shortcut Summary

Keyboard Shortcut Behavior

Ctrl+ + Zoom In

Ctrl+ - Zoom Out

Esc Deselect all shapes

Delete Deletes or Clears the selected Shape(s)/Connector(s)

Web modeler is a licensed application. In order to use it, additional licenses are required on a
per user basis.
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Enable Web Modeler

This page explains how to enable web modeler step by step

Steps to Configure Evolve Web Platform:

1. Logon to Evolve Designer.
2. Go to the Features tab

o Enable Diagramming 2 Choose Web Modeler from the drop -down list.

0 Check the Enable Swimlane Diagramming.

3. Click on Save.

4. Then click on the Configure 1IS button to configure Evolve Web Platform.
Steps to Setup Global Search:
In Evolve Designer:

1. Select the model you wish to work with, e.g. Sample Model and then click on Site.
2. If your meta -model is out of date you may need to update it. If so, click on  Update Meta Model &

Themes.
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